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第1章 编程概述 
 

 

本章介绍如何通过远程接口命令对 DS1000CA 系列数字示波器进行编程操作，以及接

口命令的格式和输入方法。 

本章内容如下： 

 通信接口 

 命令介绍 

命令格式 

符号说明 

命令输入 

参数类型 

 

说明：本书适用于 03.08.01.00.05 及以后版本的软件。 
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通信接口        

 

 

DS1000CA 系列数字示波器可通过 USB、GPIB 或 RS232 接口与计算机进行通信。程

序编译所使用的命令通常是以 ASCII 字符串形式植入主机中以便用户进行操控的。 

您能使用计算机和示波器进行的操作包括： 

 设定示波器 

 进行测量 

 从示波器获得数据（信号波形和测量数据） 
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命令介绍 

 

 

命令格式 

 

DS1000CA 系列数字示波器的命令系统为树状层次结构，每个子系统由一个根关键字

和一个或多个层次关键字构成。命令行通常以冒号“:”开始（IEEE命令除外），关键

字之间用冒号“:”分隔，关键字后面跟随可选的参数设置；命令行后面添加问号“?”，

表示对此功能进行查询；命令和参数要以“空格”分开。  

例如：  

:TRIGger:EDGE:SLOPe {POSitive|NEGative} 

:TRIGger:EDGE:SLOPe? 

TRIGger是命令的根关键字，EDGE和SLOPe分别是第二级、第三级关键字，各级关键字

用冒号“:”分开。大括号中的内容表示用户可设置的参数；问号“?”表示查询；命

令；:TRIGger:EDGE:SLOPe和参数之间用“空格”分开。 

 

 

符号说明 

 

下面的符号不是命令中的内容，但是通常用于辅助说明命令中的参数。 

1. 大括号 { } 

大括号中的内容为命令中的必选参数，每次只能从中选择一项。各个参数间以竖

线“|”分隔。 

例如：:MEASure:TOTal {ON|OFF}，该命令可选择 ON 或 OFF 作为参数。  

 

2. 方括号 [ ] 

方括号中的内容为可选项。 

例如：:TIMebase[:DELayed]:OFFSet <offset>，该命令中的[:DELayed]可省略。 

 

3. 三角括号 < > 

三角括号中的参数必须用一个有效值来替换。 

例如：:DISPlay:BRIGhtness <ncount>，该命令中的<ncount>要用一个数值来

代替，如:DISPlay:BRIGhtness 25。  
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命令输入 

 

DS1000CA 系列所有的命令对大小写输入敏感。您可以采用大写全拼或大写缩写形式

输入命令。请注意：若要使用命令缩写形式，必须完整输入命令格式中指定的大写字

母，例如： 

:TRIGger:EDGE:SLOPe 

可缩写成： 

:TRIG:EDGE:SLOP 

 

 

参数类型 

 

命令中通常有 5 种参数类型，参数的设置方法根据参数类型而定。 

1. 布尔型 

参数取值为“OFF”或“ON”。例如：:MEASure:TOTal {ON|OFF} 

“ON”表示打开（启用）功能，“OFF”表示关闭（禁用）功能。 

 

2. 连续整型 

参数取值为连续的整数，例如：:DISPlay:BRIGhtness <ncount> 

<ncount>可取 0~32（包含 0 和 32）之间的整数。 

 

3. 连续实型 

参数在有效值范围内和精度要求下，可以任意取值。例如： 

:TRIGger:EDGE:SENSitivity <count> 

<count>可取 0.1~1（包含 0.1 和 1）之间的任意实数。 

 

4. 离散型 

参数取值为所列举的值，例如：:ACQuire:AVERages <count> 

<count>只能取 2，4，8，16，32，64，128，256。 

 

5. ASCII 字符串 

参数取值为 ASCII 字符的组合。例如：:TRIGger:MODE <mode> 

<mode>可取“EDGE”、“PULSe”、“VIDEO”、“SLOPe”或“ALTernation”。 
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第2章 命令系统 
 

 

本章将详细介绍DS1000CA系列数字示波器命令系统中的每一条命令，包括命令格式、

功能描述、使用方法以及相关注意事项。 

DS1000CA 系列包含的命令系统如下： 

 通用命令 

 SYSTem 命令 

 ACQuire 命令 

 DISPlay 命令 

 TIMebase 命令 

 TRIGger 命令 

触发控制 

边沿触发 

脉宽触发 

视频触发 

斜率触发 

交替触发 

 STORage 命令 

 MATH 命令 

 CHANnel 命令 

 MEASure 命令 

 WAVeform 命令 

 KEY 命令 

 CURSor 命令 

 其他命令 
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通用命令 

 

 

IEEE 标准定义了一些用于查询仪器基本信息或执行常用基本操作的通用命令，这些命

令通常以“*”开头，命令关键字长度为 3 个字符。 

DS1000CA 系列支持的通用命令包括： 

 *IDN? 

 *RST 

 

下面将详细介绍每条命令的格式、功能和使用方法。 
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1. *IDN?  

命令格式： 

*IDN? 

 

功能描述： 

该命令查询仪器 ID 字符串。返回包含 4 个由逗号“,”分隔的字段：制造商，型

号，序列号，由点号分隔并由数字组成的版本号。 

 

返回格式： 

RIGOL TECHNOLOGIES,<示波器型号>,<产品序列号>,<软件版本号> 

 

举例： 

RIGOL TECHNOLOGIES,DS1302CA,DS1AA093200284,03.08.01 

 

 

2. *RST 

命令格式： 

*RST 

 

功能描述： 

该命令用于设置系统参数复位。 
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SYSTem 命令 

 

 

SYSTem 命令用于对示波器进行最基本的操作，主要包括运行控制、屏幕数据截取等

操作。 

SYSTem 命令包括： 

 :RUN 

 :STOP 

 :AUTO 

 :HARDcopy 

 

下面将详细介绍每条命令的格式、功能和使用方法。 
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1. :RUN 

命令格式： 

:RUN 

 

功能描述： 

执行该命令，示波器将开始波形采样工作，如需停止工作，请执行:STOP命令。 

 

 

2. :STOP 

命令格式： 

:STOP 

 

功能描述： 

执行该命令，示波器将停止波形采样工作，如需恢复工作，请执行:RUN命令。  

 

 

3. :AUTO 

命令格式： 

:AUTO 

 

功能描述： 

该命令用于自动设定仪器的控制值，通过自动设置使输入的波形达到最佳显示效

果。 

  

 

4. :HARDcopy 

命令格式： 

:HARDcopy 

 

功能描述： 

该命令用于截取示波器当前的屏幕信息，并以“HardCopyxxx.bmp”格式拷屏位

图到 U 盘中（注意：不能在文件系统中使用该命令）。 
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ACQuire 命令 

 

 

ACQuire 命令用于设置示波器的采样方式。 

ACQuire 命令包括： 

 :ACQuire:TYPE 

 :ACQuire:MODE 

 :ACQuire:AVERages 

 :ACQuire:SAMPlingrate? 

 

下面将详细介绍每条命令的格式、功能和使用方法。 
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1. :ACQuire:TYPE 

命令格式：  

:ACQuire:TYPE <type> 

:ACQuire:TYPE? 

 

功能描述： 

该命令用于设置和查询示波器当前所要采用的获取方式。<type>可取 NORMal

（普通采样）、AVERage（平均采样）或 PEAKdetect（峰值检测）。 

  

返回格式：  

查询返回 NORMAL、AVERAGE 或 PEAKDETECT。 

 

举例： 

:ACQ:TYPE AVER       设置平均采样方式    

:ACQ:TYPE?     查询返回 AVERAGE 

 

 

2. :ACQuire:MODE 

命令格式：  

:ACQuire:MODE <mode> 

:ACQuire:MODE? 

 

功能描述： 

该命令用于设置和查询示波器当前所要采用的采样方式。<mode>可取 RTIMe 

（实时采样）或 ETIMe （等效采样）。 

           

返回格式：  

查询返回 REAL_TIME 或 EQUAL_TIME。 

 

举例： 

:ACQ:MODE ETIM      设置等效采样方式 

:ACQ:MODE?     查询返回 EQUAL_TIME 

 

 

3. :ACQuire:AVERages 

命令格式：  
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:ACQuire:AVERages <count> 

:ACQuire:AVERages? 

 

功能描述： 

该命令用于设置和查询平均采样方式中的平均次数。<count>可取 2~256 之间 2

的 N 次幂整数。 

      

返回格式： 

查询返回 2、4、8、16、32、64、128 或 256。 

 

举例： 

:ACQ:AVER 16  设置平均采样次数为 16 

:ACQ:AVER?         查询返回 16 

 

 

4. :ACQuire:SAMPlingrate? 

命令格式：  

:ACQuire:SAMPlingrate? CHANnel<n> 

 

功能描述： 

该命令用于查询当前通道的采样率。<n>可取 1 或 2，分别代表通道 1 和通道 2。 

 

返回格式：  

查询返回采样率的设置值。 

 

举例： 

:ACQ:SAMP? CHAN2        查询通道 2 采样率 

1.250e+08                返回采样率为 125Msa/s 
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DISPlay 命令 

 

 

DISPlay 命令用于设置示波器的显示方式。 

DISPlay 命令包括： 

 :DISPlay:TYPE 

 :DISPlay:GRID 

 :DISPlay:PERSist 

 :DISPlay:MNUDisplay 

 :DISPlay:MNUStatus 

 :DISPlay:CLEar 

 :DISPlay:BRIGhtness 

 :DISPlay:INTensity 

 :DISPlay:SCReen  

 

下面将详细介绍每条命令的格式、功能和使用方法。 
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1. :DISPlay:TYPE 

命令格式：  

:DISPlay:TYPE <type> 

:DISPlay:TYPE? 

 

功能描述： 

该命令用于设置和查询采样点之间的显示方式。<type>可取 VECTors（矢量显示）

或 DOTS（点显示）。            

 

返回格式：  

查询返回 VECTORS 或 DOTS。 

 

举例： 

:DISP:TYPE VECT    设置显示类型为矢量显示 

:DISP:TYPE?     查询返回 VECTORS 

 

 

2. :DISPlay:GRID 

命令格式：  

:DISPlay:GRID <grid> 

:DISPlay:GRID? 

 

功能描述： 

该命令用于设置和查询屏幕网格的状态。<grid>可取 FULL（打开背景网格及坐

标）、HALF（关闭背景网格）或 NONE（关闭背景网格及坐标）。 

          

返回格式：  

查询返回 FULL、HALF 或 NONE。 

 

举例： 

:DISP:GRID FULL   打开背景网格及坐标 

:DISP:GRID?    查询返回 FULL 

 

 

3. :DISPlay:PERSist 

命令格式：  
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:DISPlay:PERSist {ON|OFF} 

:DISPlay:PERSist? 

 

功能描述： 

该命令用于设置和查询波形保持功能的开关状态。“ON”表示记录点一直保持，

直至波形保持功能关闭，“OFF”表示记录点以高刷新率变化。 

 

返回格式： 

查询返回 ON 或 OFF。 

 

举例： 

:DISP:PERS ON   打开波形保持 

:DISP:PERS?    查询返回 ON 

 

 

4. :DISPlay:MNUDisplay 

命令格式：  

:DISPlay:MNUDisplay <time> 

:DISPlay:MNUDisplay? 

 

功能描述： 

该命令用于设置和查询菜单自动隐藏的时间。<time>可取 1s、2s、5s、10s、20s

或 INFinite（无限）。 

 

返回格式：  

查询返回 1s、2s、5s、10s、20s 或 Infinite。 

 

举例： 

:DISP:MNUD 10       设置菜单显示时间为 10s 

:DISP:MNUD?    查询返回 10s 

 

 

5. :DISPlay:MNUStatus 

命令格式：  

:DISPlay:MNUStatus {ON|OFF} 

:DISPlay:MNUStaus? 
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功能描述： 

该命令用于设置和查询操作菜单的开关状态。 

 

返回格式：  

查询返回 ON 或 OFF。 

 

举例： 

:DISP:MNUS ON   打开操作菜单 

:DISP:MNUS?    查询返回 ON 

 

 

6. :DISPlay:CLEar 

命令格式：  

:DISPlay:CLEar 

 

功能描述： 

该命令用于清除开启波形保持时屏幕上保持的过期波形。 

 

 

7. :DISPlay:BRIGhtness 

命令格式：  

:DISPlay:BRIGhtness <ncount> 

:DISPlay:BRIGhtness? 

 

功能描述； 

该命令用于设置和查询网格亮度。从暗到亮的，<ncount>的取值范围为：0~32。 

 

返回格式：  

查询返回 ncount 的设置值。 

 

举例： 

:DISP:BRIG 10   设置网格亮度为 10 

:DISP:BRIG?    查询返回 10 

 

 

8. :DISPlay:INTensity 
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命令格式：  

:DISPlay:INTensity <count> 

:DISPlay:INTensity? 

 

功能描述； 

该命令用于设置和查询波形亮度，<count>的取值范围为：0~32。 

 

返回格式：  

查询返回 count 的设置值。 

 

举例： 

:DISP:INT 12   设置波形亮度为 12 

:DISP:INT?     查询返回 12 

 

 

9. :DISPlay:SCReen 

命令格式：  

:DISPlay:SCReen <scr> 

:DISPlay:SCReen? 

 

功能描述： 

该命令用于设置和查询屏幕的显示模式。<scr>可取 NORMal（正常显示模式）或

INVerted（反相显示模式）。 

 

返回格式：  

查询返回 NORMAL 或 INVERTED。 

 

举例： 

:DISP:SCR NORM      设置显示模式为正常模式 

:DISP:SCR?       查询返回 NORMAL 
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TIMebase 命令 

 

 

TIMebase 命令用于改变水平刻度（时基）和触发在内存中的水平位置（触发位移）。

改变水平刻度会使波形相对屏幕中心扩张或收缩，改变水平位置则使波形相对于触发

点的位置有偏移。 

TIMebase 命令包括： 

 :TIMebase:MODE 

 :TIMebase[:DELayed]:OFFSet 

 :TIMebase[:DELayed]:SCALe 

 :TIMebase:FORMat 

 

下面将详细介绍每条命令的格式、功能和使用方法。 
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1. :TIMebase:MODE 

命令格式： 

:TIMebase:MODE <mode> 

:TIMebase:MODE? 

 

功能描述： 

该命令用于设置和查询水平时基的扫描方式。<mode>可取 MAIN（主时基）或

DELayed（延迟扫描时基）。 

        

返回格式：  

查询返回 MAIN 或 DELAYED。 

 

举例： 

:TIM:MODE MAIN   设置水平时基为主时基 

:TIM:MODE?        查询返回 MAIN 

    

 

2. :TIMebase[:DELayed]:OFFSet 

命令格式： 

:TIMebase[:DELayed]:OFFSet <offset> 

:TIMebase[:DELayed]:OFFSet? 

 

功能描述： 

该命令用于调整 MAIN（主时基）或 Delayed（延迟扫描）时基偏移量，即波形位

置相对屏幕中心的偏移。其中： 

NORMAL 模式时，<offset>的取值范围为：1s ~ 内存深度/(2*采样率)； 

STOP 模式时，<offset>的取值范围为：-500s ~ +500s； 

SCAN 模式时，<offset>的取值范围为：-6*Scale ~ +6*Scale，其中 Scale 表示

当前的水平档位，默认单位是 s/div。 

选择 MAIN 状态时，需省略[:DELayed]选项，<offset>的取值范围为： 

    MainOffset+6*(DelayScale-MainScale) ~ MainOffset+6*(MainScale-DelayScale) 

 

返回格式： 

查询返回 offset 的设置值，单位为 s。  

 

举例： 

:TIM:MODE MAIN     设置主时基 
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:TIM:OFFS 1     设置时基偏移量为 1s 

:TIM:OFFS?     查询返回 1.000e+00 

 

 

3. :TIMebase[:DELayed]:SCALe 

命令格式：  

:TIMebase[:DELayed]:SCALe <scale_val> 

:TIMebase[:DELayed]:SCALe? 

 

功能描述： 

该命令用于设置和查询 MAIN（主时基）或 DELayed（延迟扫描时基）的时基档

位，即 s/div（秒/格）。其中： 

YT 模式时，<scale_val>的取值范围为：1ns - 50s； 

ROLL 模式时，<scale_val>的取值范围为：500ms - 50s；    

选择 MAIN 状态时，需省略[:DELayed]选项。 

 

返回格式：  

查询返回水平时基的设置值，单位为 s。 

 

举例： 

:TIM:MODE MAIN   设置主时基 

:TIM:SCAL 2    设置时基档位为 2s 

:TIM:SCAL?    查询返回 2.000e+00 

 

 

4. :TIMebase:FORMat 

命令格式： 

:TIMebase:FORMat <vlaue> 

:TIMebase:FORMat? 

 

功能描述： 

该命令用于设置和查询水平时基。<vlaue>可取 XY、YT 或 SCANning。 

        

返回格式： 

查询返回 X-Y、Y-T 或 SCANNING。 

 

举例： 
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:TIM:FORM YT   设置时基格式为 Y-T 模式 

:TIM:FORM?    查询返回 Y-T   
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TRIGger 命令 

 

 

设置触发系统是为了使示波器能够稳定显示真正有意义的波形。触发决定了示波器何

时开始采集数据和显示波形。一旦触发被正确设定，它可以将不稳定的显示转换成有

意义的波形。 

 

示波器在开始采集数据时，先收集足够的数据用来在触发点的左方画出波形。示波器

在等待触发条件发生的同时连续的采集数据，当检测到触发后，示波器连续的采集足

够的数据以在触发点的右方画出波形。 

 

DS1000CA 系列数字示波器的触发方式有：Edge（边沿）、Pulse（脉宽）、Video（视

频）、Slope（斜率）和 Alternation（交替）触发。 

TRIGger 命令包括： 

触发控制 

 :TRIGger:MODE 

 :TRIGger<mode>:SOURce 

 :TRIGger<mode>:LEVel 

 :TRIGger<mode>:SWEep 

 :TRIGger<mode>:COUPling 

 :TRIGger:HOLDoff 

 :TRIGger:STATus? 

 :Trig%50 

 :FORCetrig 

 

边沿触发 

 :TRIGger:EDGE:SLOPe 

 :TRIGger:EDGE:SENSitivity 

 

脉宽触发 

 :TRIGger:PULSe:MODE 

 :TRIGger:PULSe:SENSitivity 

 :TRIGger:PULSe:WIDTh 

 

视频触发 

 :TRIGger:VIDEO:MODE 
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 :TRIGger:VIDEO:POLarity 

 :TRIGger:VIDEO:STANdard 

 :TRIGger:VIDEO:LINE 

 :TRIGger:VIDEO:SENSitivity 

 

斜率触发 

 :TRIGger:SLOPe:TIME 

 :TRIGger:SLOPe:SENSitivity 

 :TRIGger:SLOPe:MODE 

 :TRIGger:SLOPe:WINDow 

 :TRIGger:SLOPe:LEVelA 

 :TRIGger:SLOPe:LEVelB 

 

交替触发 

 :TRIGger:ALTernation:SOURce 

 :TRIGger:ALTernation:TYPE 

 :TRIGger:ALTernation:TimeSCALe 

 :TRIGger:ALTernation:TimeOFFSet 

 :TRIGger:ALTernation<mode>:LEVel 

 :TRIGger:ALTernation:EDGE:SLOPe 

 :TRIGger:ALTernation<mode>:MODE 

 :TRIGger:ALTernation<mode>:TIME 

 :TRIGger:ALTernation:VIDEO:POLarity 

 :TRIGger:ALTernation:VIDEO:STANdard 

 :TRIGger:ALTernation:VIDEO:LINE 

 :TRIGger:ALTernation:SLOPe:WINDow 

 :TRIGger:ALTernation:SLOPe:LEVelA 

 :TRIGger:ALTernation:SLOPe:LEVelB 

 :TRIGger:ALTernation<mode>:COUPling 

 :TRIGger:ALTernation<mode>:HOLDoff 

 :TRIGger:ALTernation<mode>:SENSitivity 

 

下面将详细介绍每条命令的格式、功能和使用方法。 
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触发控制 
 

 

1. :TRIGger:MODE 

命令格式： 

:TRIGger:MODE <mode> 

:TRIGger:MODE? 

 

功能描述： 

该命令用于设置和查询触发模式。<mode>可取 EDGE（边沿）、PULSe（脉宽）、

SLOPE（斜率）、VIDEO（视频）和 ALTernation（交替）触发。 

   

返回格式： 

查询返回 EDGE、PULSE、SLOPE、VIDEO 或 ALTERNATION。 

 

举例： 

:TRIG:MODE EDGE   设置边沿触发方式 

:TRIG:MODE?    查询返回 EDGE 

 

    

2. :TRIGger<mode>:SOURce 

命令格式： 

:TRIGger<mode>:SOURce <src> 

:TRIGger<mode>:SOURce? 

 

功能描述： 

该命令用于设置和查询触发信源。<src>可取输入通道（CHANnel1、CHANnel2）、

外部触发通道（EXT、EXT/5）或 AC Line（市电）。 

当 mode 为:EDGE 时，<src>可取 CHANnel<n>、EXT、EXT5 或 ACLine； 

当 mode 为:PULSE 时，<src>可取 CHANnel<n> 、EXT 或 EXT5； 

当 mode 为:SLOPE 时，<src>可取 CHANnel<n>、 EXT 或 EXT5； 

当 mode 为:VIDEO 时，<src>可取 CHANnel<n>、 EXT 或 EXT5。 

其中，<n>可取 1 或 2。 

 

返回格式：  

查询返回 CH1、CH2、EXT、EXT5 或 ACLINE。 

 



命令系统                                                                        RIGOL 

 
DS1000CA 系列数字示波器编程手册 2-21 

举例： 

:TRIG:EDGE:SOUR CHAN1         设置边沿触发信源为通道 1 

:TRIG:EDGE:SOUR?    查询返回 CH1 

 

 

3. :TRIGger<mode>:LEVel 

命令格式：  

:TRIGger<mode>:LEVel <level> 

:TRIGger<mode>:LEVel? 

 

功能描述： 

该命令用于设置和查询触发电平。<mode>可取:EDGE、:PULSe 或:VIDEO。

<level>的取值范围为：-6*Scale~+6*Scale（距屏幕中心），Scale 表示当前的垂

直档位，默认单位是 V/div。  

 

返回格式：  

查询返回 level 的设置值，单位为 V。 

 

举例： 

:TRIG:EDGE:LEV 2  设置边沿触发的触发电平为 2  

:TRIG:EDGE:LEV？  查询返回 2.00e+00 

 

 

4. :TRIGger<mode>:SWEep 

命令格式：  

:TRIGger<mode>:SWEep {AUTO|NORMal|SINGle} 

:TRIGger<mode>:SWEep? 

 

功能描述： 

该命令用于设置和查询触发方式。<mode>可取:EDGE、:PULSe、:VIDEO

或:SLOPe。 

 

返回格式：  

查询返回 AUTO、NORMAL 或 SINGLE。 

 

举例： 

:TRIG:EDGE :SWE AUTO     设置自动触发方式 
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:TRIG:EDGE :SWE?   查询返回 AUTO 

 

 

5. :TRIGger<mode>:COUPling 

命令格式： 

:TRIGger<mode>:COUPling {DC|AC|HF|LF} 

:TRIGger<mode>:COUPling? 

 

功能描述： 

该命令用于设置和查询耦合方式。<mode>可取:EDGE、:PULSe 或:SLOPe。 

其中： 

DC（直流）：让信号的所有分量通过； 

AC（交流）：阻挡“直流”成分并衰减 10Hz 以下的信号； 

HF（高频抑制）：衰减超过 150kHz 的高频分量； 

LF（低频抑制）：阻挡直流分量并衰减低于 8kHz 的低频成分； 

 

返回格式：  

查询返回 DC、AC、HF 或 LF。 

 

举例： 

:TRIG:EDGE:COUP DC  设置耦合方式为直流 

:TRIG:EDGE:COUP？      查询返回 DC 

 

 

6. :TRIGger:HOLDoff 

命令格式：  

:TRIGger:HOLDoff <count> 

:TRIGger:HOLDoff? 

 

功能描述： 

该命令用于设置和查询触发释抑时间。<count>的取值范围为：500ns~1.5s。 

 

返回格式：  

查询返回 count 的设置值，单位为 s。 

 

举例： 

:TRIG:HOLD 0.0001      设置触发释抑时间为 100 微秒 
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:TRIG:HOLD?     查询返回 1.000e-04 

 

 

7. :TRIGger:STATus? 

命令格式：  

:TRIGger:STATus? 

功能描述： 

该命令用于查询当前示波器的运行状态。这些状态有：RUN（运行）、STOP（停

止）、T`D（已触发）、WAIT（等待）和 AUTO（自动）。 

 

返回格式：  

查询返回 RUN、STOP、T'D、WAIT 或 AUTO。 

 

 

8. :Trig%50 

命令格式： 

:Trig%50 

 

功能描述： 

该命令用于设定触发电平值至信号幅值的垂直中点。 

 

 

9. :FORCetrig 

命令格式： 

:FORCetrig 

 

功能描述： 

该命令用于强制示波器产生触发信号，主要应用于“普通”和“单次”触发模式。 
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边沿触发 

 

 

1. :TRIGger:EDGE:SLOPe 

命令格式： 

:TRIGger:EDGE:SLOPe {POSitive|NEGative|ALTernation} 

:TRIGger:EDGE:SLOPe? 

 

功能描述： 

该命令用于设置和查询边沿触发的边沿类型为 POSitive（上升沿）、NEGative（下

降沿）或 ALTernation（上升下降沿）。 

 

返回格式：  

查询返回 POSITIVE、NEGATIVE 或 ALTERNATION。 

 

举例： 

:TRIG:EDGE:SLOP POS        设置触发边沿类型为上升沿 

:TRIG:EDGE:SLOP?       查询返回 POSITIVE 

 

 

2. :TRIGger:EDGE:SENSitivity  

命令格式： 

:TRIGger:EDGE:SENSitivity <count> 

:TRIGger:EDGE:SENSitivity? 

 

功能描述： 

该命令用于设置和查询边沿触发的触发灵敏度。 

<count>的取值范围为；0.1~1。 

 

返回格式： 

查询返回 count 的设置值，单位为 div。 

 

举例： 

:TRIG:EDGE:SENS 0.5        设置触发灵敏度为 0.5div 

:TRIG:EDGE:SENS？          查询返回 5.00e-01 
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脉宽触发 

 

 

1. :TRIGger:PULSe:MODE 

命令格式： 

:TRIGger:PULSe:MODE <mode> 

:TRIGger:PULSe:MODE? 

 

功能描述： 

该命令用于设置和查询脉宽触发的脉冲条件。<mode>可取+GREaterthan（正脉

宽大于）、+LESSthan（正脉宽小于）、+ EQUal（正脉宽等于）、-GREaterthan（负

脉宽大于）、-LESSthan（负脉宽小于）或-EQUal（负脉宽等于）。 

         

返回格式：  

查询返回+GREATER THAN、+LESS THAN、+EQUAL、-GREATER THAN、-LESS 

THAN 或-EQUAL。 

 

举例： 

:TRIG:PULS:MODE +GRE          设置脉冲条件为“正脉宽大于” 

:TRIG:PULS:MODE?    查询返回+GREATER THAN 

 

 

2. :TRIGger:PULSe:SENSitivity 

命令格式： 

:TRIGger:PULSe:SENSitivity <count> 

:TRIGger:PULSe:SENSitivity? 

 

功能描述： 

该命令用于设置和查询脉宽触发的触发灵敏度。 

<count>的取值范围为；0.1~1。 

 

返回格式： 

查询返回 count 的设置值，单位为 div。 

 

举例： 

:TRIG:PULS:SENS 0.5        设置触发灵敏度为 0.5div 

:TRIG:PULS:SENS?           查询返回 5.00e-01 
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3. :TRIGger:PULSe:WIDTh 

命令格式：  

:TRIGger:PULSe:WIDTh <wid> 

:TRIGger:PULSe:WIDTh? 

 

功能描述： 

该命令用于设置和查询脉冲的宽度。<wid>的取值范围为：20ns ~ 10s。 

 

返回格式：  

查询返回 wid 的设置值，单位为 s。 

 

举例： 

:TRIG:PULS:WIDT 0.001     设置脉冲宽度为 1ms 

:TRIG:PULS:WIDT?    查询返回 1.000e-03 
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视频触发 

 

 

1. :TRIGger:VIDEO:MODE 

命令格式：  

:TRIGger:VIDEO:MODE <mode> 

:TRIGger:VIDEO:MODE? 

 

功能描述： 

该命令用于设置和查询视频触发的同步方式。<mode>可取 ODDfield（奇数场）、

EVENfield（偶数场）、LINE（指定行）或 ALLlines（所有行）。 

          

返回格式：  

查询返回 ODD FIELD、EVEN FIELD、LINE 或 ALL LINES。 

 

举例： 

:TRIG:VIDEO:MODE EVEN        设置触发同步方式为偶数场 

:TRIG:VIDEO:MODE?       查询返回 EVEN FIELD 

 

 

2. :TRIGger:VIDEO:POLarity 

命令格式： 

:TRIGger:VIDEO:POLarity {POSitive|NEGative} 

:TRIGger:VIDEO:POLarity? 

 

功能描述： 

该命令用于设置和查询视频触发的视频极性为 POSitive（正极性）或 NEGative（负

极性）。 

 

返回格式：  

查询返回 POSITIVE 或 NEGATIVE。 

 

举例： 

:TRIG:VIDEO:POL POS        设置视频极性为正极性 

:TRIG:VIDEO:POL?    查询返回 POSITIVE  
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3. :TRIGger:VIDEO:STANdard 

命令格式：  

:TRIGger:VIDEO:STANdard {NTSC|PALSecam} 

:TRIGger:VIDEO:STANdard? 

 

功能描述： 

该命令用于设置和查询视频触发的视频标准。 

 

返回格式： 

查询返回 NTSC、PAL/SECAM。 

 

举例： 

:TRIG:VIDEO:STAN PALS         选择视频标准为 PALSecam 

:TRIG:VIDEO:STAN?      查询返回 PAL/SECAM 

 

 

4. :TRIGger:VIDEO:LINE 

命令格式：  

:TRIGger:VIDEO:LINE <value> 

:TRIGger:VIDEO:LINE? 

 

功能描述； 

该命令用于设置和查询同步的指定行数。NTSC 标准下，<value>的取值范围为：

1~525；PAL/SECAM 标准下，<value>的取值范围为：1~625。 

 

返回格式：  

查询返回当前所指定的行数。 

 

举例： 

:TRIG:VIDEO:LINE 25         设置同步的指定行数为 25 

:TRIG:VIDEO:LINE?      查询返回 25 

 

 

5. :TRIGger:VIDEO:SENSitivity 

命令格式： 

:TRIGger:VIDEO:SENSitivity <count> 
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:TRIGger:VIDEO:SENSitivity? 

 

功能描述： 

该命令用于设置和查询视频触发的触发灵敏度。 

<count>的取值范围为；0.1~1。 

 

返回格式： 

查询返回 count 的设置值，单位为 div。 

 

举例： 

:TRIG:VIDEO:SENS 0.5       设置触发灵敏度为 0.5div 

:TRIG:VIDEO:SENS?          查询返回 5.00e-01 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



RIGOL                                                                        命令系统 

  
DS1000CA 系列数字示波器编程手册 2-30 

斜率触发 

 

 

1. :TRIGger:SLOPe:TIME 

命令格式：  

:TRIGger:SLOPe:TIME <count> 

:TRIGger:SLOPe:TIME? 

 

功能描述： 

该命令用于调整和查询斜率触发的时间设置。<count>的取值范围为：20ns~10s。 

         

返回格式：  

查询返回 count 的设置值，单位为 s。 

 

举例： 

:TRIG:SLOP:TIME 0.01        设置斜率时间为 10ms 

:TRIG:SLOP:TIME?    查询返回 1.000e-02 

 

 

2. :TRIGger:SLOPe:SENSitivity 

命令格式： 

:TRIGger:SLOPe:SENSitivity <count> 

:TRIGger:SLOPe:SENSitivity? 

 

功能描述： 

该命令用于设置和查询斜率触发的触发灵敏度。 

<count>的取值范围为；0.1~1。 

 

返回格式： 

查询返回 count 的设置值，单位为 div。 

 

举例： 

:TRIG:SLOP:SENS 0.5        设置触发灵敏度为 0.5div 

:TRIG:SLOP:SENS?           查询返回 5.00e-01 

 

 

3. :TRIGger:SLOPe:MODE 
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命令格式：  

:TRIGger:SLOPe:MODE <mode> 

:TRIGger:SLOPe:MODE? 

 

功能描述： 

该命令用于设置和查询斜率触发的斜率条件。<mode>可取+GREaterthan（正斜

率大于）、+LESSthan（正斜率小于）、+ EQUal（正斜率等于）、-GREaterthan（负

斜率大于）、-LESSthan（负斜率小于）或-EQUal（负斜率等于）。 

 

返回格式：  

查询返回+GREATER THAN、+LESS THAN、+EQUAL、-GREATER THAN、-LESS 

THAN 或-EQUAL。 

 

举例： 

:TRIG:SLOP:MODE +GRE        设置斜率条件为“正斜率大于” 

:TRIG:SLOPe:MODE?      查询返回+GREATER THAN 

 

 

4. :TRIGger:SLOPe:WINDow 

命令格式： 

:TRIGger:SLOPe:WINDow <count> 

:TRIGger:SLOPe:WINDow? 

 

功能描述： 

该命令用于设置和查询垂直窗的触发电平。 

当斜率条件为+GREaterthan、+LESSthan 或+ EQUal 时，<count>可取 PA（上

升沿 Level A）、PB（上升沿 Level B）或 PAB（上升沿 Level AB）； 

当斜率条件为-GREaterthan、-LESSthan 或-EQUal 时，<count>可取 NA（下降沿 

Level A）、NB（下降沿 LevelB）或 NAB（下降沿 LevelAB）。 

 

返回格式：  

查询返回 P_WIN_A、P_WIN_B、P_WIN_AB、N_WIN_A、N_WIN_B 或 N_WIN_AB。 

 

举例： 

:TRIG:SLOP:WIND PA         设置触发电平上限为上升沿 Level A 

:TRIG:SLOP:WIND?   查询返回 P_WIN_A 
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5. :TRIGger:SLOPe:LEVelA 

命令格式： 

:TRIGger:SLOPe:LEVelA <value> 

:TRIGger:SLOPe:LEVelA? 

 

功能描述： 

该命令用于设置和查询触发电平的上边界 Level A。<value>的取值范围为：

LevelB~+6*Scale，Scale 表示当前的垂直档位，单位为 V/div。 

 

返回格式：  

查询返回 value 的设置值，单位为 V。 

 

举例： 

:TRIG:SLOP:LEVA 2        设置触发电平上边界为 2V 

:TRIG:SLOP:LEVA?    查询返回 2.000e+00 

 

 

6. :TRIGger:SLOPe:LEVelB 

命令格式：  

:TRIGger:SLOPe:LEVelB <value> 

:TRIGger:SLOPe:LEVelB? 

 

功能描述： 

该命令用于设置和查询触发电平的下边界 LEVel B。<value>的取值范围为；

-6*Scale~LevelA，Scale 表示当前的垂直档位，单位为 V/div。 

 

返回格式：  

查询返回 value 的设置值，单位为 V。 

注：Level A（上边界）的最小值不能小于 Level B（下边界）的最大值。 

 

举例： 

:TRIG:SLOP:LEVB -1.5        设置触发电平下边界为-1.5V 

:TRIG:SLOP:LEVB?    查询返回-1.500e+00 
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交替触发 

  

 

1. :TRIGger:ALTernation:SOURce 

命令格式：  

:TRIGger:ALTernation:SOURce <src> 

:TRIGger:ALTernation:SOURce? 

 

功能描述： 

该命令用于设置和查询将要进行操作的通道。<src>可取CHANnel1或CHANnel2。  

 

返回格式：  

查询返回 CH1 或 CH2。 

 

举例： 

:TRIG:ALT:SOUR CHAN2        选择通道 2 进行操作 

:TRIG:ALT:SOUR?      查询返回 CH2 

 

 

2. :TRIGger:ALTernation:TYPE 

命令格式：  

:TRIGger:ALTernation:TYPE <value> 

:TRIGger:ALTernation:TYPE? 

 

功能描述： 

该命令用于设置和查询交替触发模式下当前通道的触发类型。<value>可取 EDGE

（边沿）、PULSe（脉宽）、SLOPe（斜率）或 VIDEO（视频）触发。 

 

返回格式：  

查询返回 EDGE、PULSE、SLOPE 或 VIDEO。 

 

举例： 

:TRIG:ALT:TYPE EDGE        设置触发类型为边沿触发 

:TRIG:ALT:TYPE?    查询返回 EDGE 

 

 

3. :TRIGger:ALTernation:TimeSCALe 
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命令格式：  

:TRIGger:ALTernation:TimeSCALe <value> 

:TRIGger:ALTernation:TimeSCALe? 

 

功能描述： 

该命令用于设置和查询当前通道的时基。<value>的取值范围为：2ns～20ms。 

            

返回格式：  

查询返回 value 的设置值，单位为 s。 

 

举例： 

:TRIG:ALT:TSCAL 0.001        设置时基为 1ms 

:TRIG:ALT:TSCAL?     查询返回 1.000e-03 

 

 

4. :TRIGger:ALTernation:TimeOFFSet 

命令格式：  

:TRIGger:ALTernation:TimeOFFSet <value> 

:TRIGger:ALTernation:TimeOFFSet? 

 

功能描述： 

该命令用于设置和查询当前通道的水平时基偏移。其中， 

当 NORMAL 模式时，<value>的取值范围为：1s ~ 内存终点； 

当 STOP 模式时，<value>的取值范围为：-500s ~ +500s； 

当 ROLL 模式时，<value>的取值范围为：-6*Scale~+6*Scale。 

Scale 表示当前的水平档位，单位为 s/div。 

 

返回格式：  

查询返回 value 的设置值，单位为 s。 

        

举例： 

:TRIG:ALT:TOFFS 0.0002        设置当前通道的水平时基为 200us 

:TRIG:ALT:TOFFS?      查询返回 2.000e-04 

 

 

5. :TRIGger:ALTernation<mode>:LEVel 

命令格式：  
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:TRIGger:ALTernation<mode>:LEVel <value> 

:TRIGger:ALTernation<mode>:LEVel? 

 

功能描述： 

该命令用于设置和查询当前通道的触发电平。<mode>可取:EDGE、:PULSe

或:VIDEO。<value>的取值范围为：- 6*Scale~+6*Scale，Scale 表示当前的垂

直档位，单位为 V/div。 

 

返回格式：  

查询返回 value 的设置值，单位 V。 

 

举例： 

:TRIG:ALT:EDGE:LEV 2        设置当前通道的触发电平为 2V 

:TRIG:ALT:EDGE:LEV?       查询返回 2.00e+00 

 

 

6. :TRIGger:ALTernation:EDGE:SLOPe 

命令格式：  

:TRIGger:ALTernation:EDGE:SLOPe <value> 

:TRIGger:ALTernation:EDGE:SLOPe? 

 

功能描述： 

该命令用于设置和查询当前操作状态下边沿触发的边沿类型。<value>可取

POSitive（上升沿）、NEGative（下降沿）或 ALTernation（上升和下降沿）。 

 

返回格式：  

查询返回 POSITIVE、NEGATIVE 或 ALTERNATION。 

 

举例： 

:TRIG:ALT:EDGE:SLOP POS        设置边沿类型 

:TRIG:ALT:EDGE:SLOP?   查询返回 POSITIVE 

 

 

7. :TRIGger:ALTernation<mode>:MODE 

命令格式：  

:TRIGger:ALTernation<mode>:MODE <value> 

:TRIGger:ALTernation<mode>:MODE? 
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功能描述： 

该命令用于设置或查询当前操作状态下脉宽触发的脉冲条件、斜率触发的斜率条

件或视频触发的同步设置。<mode>可取:PULSe、:SLOPe 或:VIDEO。 

当<mode>为:PULSe 或:SLOPe 时，<value>可取+GREaterthan、+LESSthan、+ 

EQUal、-GREaterthan、-LESSthan 或-EQUal； 

当<mode>为:VIDEO 时，<value>可取 ODDfield、EVENfield、LINE 或 ALLlines。 

 

返回格式： 

查询返回 value 的设置值。 

 

举例： 

:TRIG:ALT:PULS:MODE +GRE        设置脉冲条件为“正脉宽大于” 

:TRIG:ALT:PULS:MODE?         查询返回+GREATER THAN 

 

 

8. :TRIGger:ALTernation<mode>:TIME 

命令格式：  

:TRIGger:ALTernation<mode>:TIME <value> 

:TRIGger:ALTernation<mode>:TIME? 

 

功能描述： 

该命令用于设置和查询当前操作状态下脉宽触发的脉冲宽度或斜率触发的斜率时

间。<mode>可取:SLOPe 或:PULSe，<value>的取值范围为：20ns~10s。    

 

返回格式：  

查询返回 value 的设置值，单位为 s。 

 

举例： 

:TRIG:ALT:SLOP:TIME 0.002        设置斜率时间为 2ms 

:TRIG:ALT:SLOP:TIME?      查询返回 2.000e-03 

 

 

9. :TRIGger:ALTernation:VIDEO:POLarity 

命令格式：  

:TRIGger:ALTernation:VIDEO:POLarity {POSitive|NEGative} 

:TRIGger:ALTernation:VIDEO:POLarity? 
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功能描述： 

该命令用于设置和查询当前操作状态下视频触发的视频极性。 

 

返回格式： 

查询返回 POSITIVE 或 NEGATIVE。 

 

举例： 

:TRIG:ALT:VIDEO:POL POS      设置视频极性为正极性 

:TRIG:ALT:VIDEO:POL?      查询返回 POSITIVE 

 

 

10. :TRIGger:ALTernation:VIDEO:STANdard 

命令格式：  

:TRIGger:ALTernation:VIDEO:STANdard {NTSC|PALSecam} 

:TRIGger:ALTernation:VIDEO:STANdard? 

 

功能描述： 

该命令用于设置和查询当前操作状态下视频触发的视频标准。 

 

返回格式：  

查询返回 NTSC 或 PAL/SECAM。 

 

举例： 

:TRIG:ALT:VIDEO:STAN NTSC        设置视频标准为 NTSC 

:TRIG:ALT:VIDEO:STAN?      查询返回 NTSC 

 

 

11. :TRIGger:ALTernation:VIDEO:LINE 

命令格式：  

:TRIGger:ALTernation:VIDEO:LINE <value> 

:TRIGger:ALTernation:VIDEO:LINE? 

 

功能描述： 

该命令用于设置和查询当前操作状态下同步的指定行数。NTSC 标准下，<value>

的取值范围为：1~525；PAL/SECAM 标准下，<value>的取值范围为：1~625。 

 

返回格式：  
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查询返回 value 的设置值。 

 

举例： 

:TRIG:ALT:VIDEO:LINE 100        设置同步的指定行数为 100 

:TRIG:ALT:VIDEO:LINE?    查询返回 100 

 

 

12. :TRIGger:ALTernation:SLOPe:WINDow 

命令格式：  

:TRIGger:ALTernation:SLOPe:WINDow <count> 

:TRIGger:ALTernation:SLOPe:WINDow? 

功能描述：  

该命令用于设置和查询当前操作状态下垂直窗的触发电平。 

当斜率条件为+GREaterthan、+LESSthan 或+ EQUal 时，<count>可取 PA（上

升沿 Level A）、PB（上升沿 Level B）或 PAB（上升沿 Level AB）； 

当斜率条件为-GREaterthan、-LESSthan 或-EQUal 时，<count>可取 NA（下降沿 

Level A）、NB（下降沿 LevelB）或 NAB（下降沿 LevelAB）。 

 

返回格式：  

查询返回 P_WIN_A、P_WIN_B、P_WIN_AB、N_WIN_A、N_WIN_B 或 N_WIN_AB。 

 

举例： 

:TRIG:ALT:SLOP:WIND PA      设置调节触发电平边界为 Level A 

:TRIG:ALT:SLOP:WIND?   查询返回 P_WIN_A 

 

 

13. :TRIGger:ALTernation:SLOPe:LEVelA 

命令格式： 

:TRIGger:ALTernation:SLOPe:LEVelA <value> 

:TRIGger:ALTernation:SLOPe:LEVelA? 

 

功能描述： 

该命令用于设置和查询当前操作状态下斜率触发的触发电平上边界 Level A。

<value>的取值范围为：LevelB~+6*Scale，Scale 表示当前的垂直档位，单位为

V/div。 
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返回格式： 

查询返回 value 的设置值，单位为 V。 

 

举例： 

:TRIG:ALT:SLOP:LEVA 2         设置触发电平上边界 Level A 为 2V 

:TRIG:ALT:SLOP:LEVA?   查询返回 2.000e+00 

 

14. :TRIGger:ALTernation:SLOPe:LEVelB 

命令格式：  

:TRIGger:ALTernation:SLOPe:LEVelB <value> 

:TRIGger:ALTernation:SLOPe:LEVelB? 

 

功能描述： 

该命令用于设置和查询当前操作状态下斜率触发的触发电平下边界 Level B。

<value>的取值范围为：-6*Scale~LevelA，Scale 表示当前的垂直档位，单位为

V/div。  

注：Level A（上边界）的最小值不能小于 Level B（下边界）的最大值。  

 

返回格式： 

查询返回 value 的设置值，单位为 V。 

 

举例： 

:TRIG:ALT:SLOP:LEVB -1.5         设置触发电平下边界 Level B 为-1.5V 

:TRIG:ALT:SLOP:LEVB ?   查询返回-1.500e+00 

 

 

15. :TRIGger:ALTernation<mode>:COUPling 

命令格式： 

:TRIGger:ALTernation<mode>:COUPling {DC|AC|HF|LF} 

:TRIGger:ALTernation<mode>:COUPling? 

 

功能描述： 

该命令用于设置和查询耦合方式。其中： 

DC（直流）：让信号的所有分量通过； 

AC（交流）：阻挡“直流”成分并衰减 10Hz 以下的信号； 

HF（高频抑制）：衰减超过 150kHz 的高频分量； 
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LF（低频抑制）：阻挡直流分量并衰减低于 8kHz 的低频成分； 

<mode>可取:EDGE、:PULSe 或:SLOPe。 

      

返回格式：  

查询返回 DC 、AC、HF 或 LF。 

 

举例：  

:TRIG:ALT:EDGE:COUP DC         设置耦合方式为直流 

:TRIG:ALT:EDGE:COUP?   查询返回 DC 

 

 

16. :TRIGger:ALTernation<mode>:HOLDoff 

命令格式： 

:TRIGger:ALTernation<mode>:HOLDoff <count> 

:TRIGger:ALTernation<mode>:HOLDoff? 

 

功能描述： 

该命令用于设置和查询触发释抑。<mode>可取 :EDGE、 :PULSe、 :SLOPe

或:VIDEO。<count>的取值范围为：500ns~1.5s。 

 

返回格式； 

查询返回 count 的设置值，单位为 s。 

 

举例： 

:TRIG:ALT:PULS:HOLD 1        设置触发释抑为 1s 

:TRIG:ALT:PULS:HOLD?         查询返回 1.000e+00 

 

17. :TRIGger:ALTernation<mode>:SENSitivity 

命令格式： 

:TRIGger:ALTernation<mode>:SENSitivity <count> 

:TRIGger:ALTernation<mode>:SLOPe:SENSitivity? 

 

功能描述； 

该命令用于设置和查询交替触发的触发灵敏度。 

<mode>可取:EDGE、:PULSe、:SLOPe 或:VIDEO。<count>的取值范围为：0.1~1。 
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返回格式： 

查询返回 count 的设置值，单位为 div。 

 

举例： 

:TRIG:ALT:EDGE:SENS 0.5         设置触发灵敏度为 0.5div 

:TRIG:ALT:EDGE:SLOP:SENS?      查询返回 5.00e-01 
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STORage 命令 

 

 

STORage 命令用于调出出厂设置。 

STORage 命令包括： 

 :STORage:FACTory:LOAD 

 

下面将详细介绍每条命令的格式、功能和使用方法。 
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1. :STORage:FACTory:LOAD 

命令格式： 

:STORage:FACTory:LOAD 

 

功能描述： 

执行该命令，调用系统的出厂设置。 
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MATH 命令 

 

 

MATH（数学运算）功能用于执行 CH1、CH2 通道波形相加、相减、相乘以及 FFT 运

算操作，运算结果可采用栅格或游标进行测量并通过屏幕显示出来。 

MATH 命令包括： 

 :MATH:DISPlay 

 :MATH:OPERate 

 :FFT:DISPlay 

 

下面将详细介绍每条命令的格式、功能和使用方法。 
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1. :MATH:DISPlay 

命令格式： 

:MATH:DISPlay {ON|OFF} 

:MATH:DISPlay? 

 

功能描述： 

该命令用于设置和查询数学运算功能的开关状态。 

 

返回格式：  

查询返回 ON 或 OFF。 

 

举例： 

:MATH:DISP ON   打开数学运算功能 

:MATH:DISP?    查询返回 ON 

 

 

2. :MATH:OPERate 

命令格式： 

:MATH:OPERate <operate> 

:MATH:OPERate? 

 

功能描述： 

该命令用于设置和查询当前通道进行的数学运算类型。<operate>可取 A+B、A-B、

AB 或 FFT。 

 

返回格式： 

查询返回 A+B、A-B、A*B 或 FFT。 

 

举例： 

:MATH:OPER AB       设置 MATH 的运算类型为 AB 

:MATH:OPER?          查询返回 A*B 

 

 

3. :FFT:DISPlay 

命令格式：  

:FFT:DISPlay {ON|OFF} 
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:FFT:DISPlay? 

 

功能描述： 

该命令用于设置和查询 FFT 运算功能的开关状态。 

 

返回格式：  

查询返回 ON 或 OFF。 

 

举例： 

:FFT:DISP ON   打开 FFT 运算功能 

:FFT:DISP?    查询返回 ON 
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CHANnel 命令 

 

 

CHANnel 命令用于对仪器的两个通道进行控制。每个通道有独立的垂直菜单。每个项

目都按不同的通道单独设置。 

CHANnel 命令包括： 

 :CHANnel<n>:BWLimit 

 :CHANnel<n>:COUPling 

 :CHANnel<n>:DISPlay 

 :CHANnel<n>:INVert 

 :CHANnel<n>:OFFSet 

 :CHANnel<n>:PROBe 

 :CHANnel<n>:SCALe 

 :CHANnel<n>:FILTer 

 :CHANnel<n>:VERNier 

 :CHANnel<n>:INPut 

 

下面将详细介绍每条命令的格式、功能和使用方法。 
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1. :CHANnel<n>:BWLimit 

命令格式： 

:CHANnel<n>:BWLimit {ON|OFF} 

:CHANnel<n>:BWLimit? 

 

功能描述： 

该命令用于设置和查询带宽限制的开关状态。<n>可取 1 或 2。 

 

返回格式：  

查询返回 ON 或 OFF。 

 

举例： 

:CHAN2:BWL OFF   关闭通道 2 的带宽限制     

:CHAN2:BWL?   查询返回 OFF 

 

  

2. :CHANnel<n>:COUPling 

命令格式：  

:CHANnel<n>:COUPling {DC|AC|GND} 

:CHANnel<n>:COUPling? 

 

功能描述： 

该命令用于设置和查询通道的耦合方式。DC（直流）表示可通过输入信号的交流

和直流分量；AC（交流）表示阻挡输入信号的直流分量；GND（接地）表示断开

输入信号。<n>可取 1 或 2。 

 

返回格式：  

查询返回 AC、DC 或 GND。 

 

举例： 

:CHAN2:COUP DC   设置通道 2 为直流耦合方式 

:CHAN2:COUP?    查询返回 DC 

 

 

3. :CHANnel<n>:DISPlay 

命令格式： 
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:CHANnel<n>:DISPlay {ON|OFF} 

:CHANnel<n>:DISPlay? 

 

功能描述： 

该命令用于设置和查询通道的开关状态。<n>可取 1 或 2。 

 

返回格式：  

查询返回 1/0。其中，1 代表通道已打开，0 代表通道未打开。 

 

举例： 

:CHAN2:DISP ON       打开通道 2 显示 

:CHAN2:DISP?    查询返回 1 

 

 

4. :CHANnel<n>:INVert 

命令格式：  

:CHANnel<n>:INVert {ON|OFF} 

:CHANnel<n>:INVert? 

 

功能描述： 

该命令用于设置和查询波形反相功能的开关状态。<n>可取 1 或 2。 

 

返回格式：  

查询返回 ON 或 OFF。 

 

举例： 

:CHAN2:INV OFF   关闭通道 2 的反相显示 

:CHAN2:INV?    查询返回 OFF 

 

 

5. :CHANnel<n>:OFFSet 

命令格式： 

:CHANnel<n>:OFFSet <offset> 

:CHANnel<n>:OFFSet? 

 

功能描述： 

该命令用于设置和查询波形在垂直方向上的位移。<n>可取 1 或 2，并且： 
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当 Scale>200mV，<offset>的取值范围为：-40V~+40V；  

当 Scale≤200mV，<offset>的取值范围为：-800mV~+800mV。 

      

返回格式：   

查询返回 offset 的设置值，单位 V。 

 

举例： 

:CHAN2:OFFS 20      设置通道 2 垂直位置为 20V 

:CHAN2:OFFS?      查询返回 2.000e+01 

 

 

6. :CHANnel<n>:PROBe 

命令格式： 

:CHANnel<n>:PROBe <attn> 

:CHANnel<n>:PROBe? 

 

功能描述： 

该命令用于设置和查询探头的衰减因数。<n> 可取 1 或 2，<attn>可取 1、5、

10、50、100、500 或 1000，以保持垂直标尺读数准确。 

 

返回格式：  

查询返回 attn 的设置值。 

 

举例： 

:CHAN2:PROB 10      设置通道 2 探头衰减比例为 10X 

:CHAN2:PROB?   查询返回 1.000e+01 

 

 

7. :CHANnel<n>:SCALe 

命令格式：  

:CHANnel<n>:SCALe <range> 

:CHANnel<n>:SCALe? 

 

功能描述： 

该命令用于设置和查询示波器在垂直方向上放大波形的档位。<n>可取 1 或 2，

并且：  
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当 Probe 设置为 1X 时，<range>的取值范围为：1mV~10V； 

当 Probe 设置为 5X 时，<range>的取值范围为：5mV~50V ； 

当 Probe 设置为 10X 时，<range>的取值范围为：10mV ~ 100V；  

当 Probe 设置为 50X 时，<range>的取值范围为：50mV~500V； 

当 Probe 设置为 100X 时，<range>的取值范围为：100mV ~ 1000V； 

当 Probe 设置为 500X 时，<range>的取值范围为：500mV~5000V； 

当 Probe 设置为 1000X 时，<range>的取值范围为：1V~10000V。 

 

返回格式：  

查询返回 range 的设置值，单位为 V。 

 

举例： 

:CHAN2:PROB 10      设置探头衰减比为 10X 

:CHAN2:SCAL 20   设置垂直档位为 20V 

:CHAN2:SCAL?   查询返回 2.000e+01 

 

 

8. :CHANnel<n>:FILTer 

命令格式：  

:CHANnel<n>:FILTer {ON|OFF} 

:CHANnel<n>:FILTer? 

 

功能描述： 

该命令用于设置和查询数字滤波功能的开关状态。<n>可取 1 或 2。 

 

返回格式：  

查询返回 ON 或 OFF。 

 

举例： 

:CHAN2:FILT OFF       关闭通道 2 的数字滤波    

:CHAN2:FILT?    查询返回 OFF 

 

 

9. :CHANnel<n>:VERNier 

命令格式： 

:CHANnel<n>:VERNier {ON|OFF} 

:CHANnel<n>:VERNier?  
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功能描述： 

该命令用于设置和查询档位调节方式。ON 表示微调（Fine），OFF 表示粗调

（Coarse）。<n>可取 1 或 2。 

 

返回格式：  

查询返回 Coarse 或 Fine。 

 

举例： 

:CHAN2:VERN ON   打开微调功能 

:CHAN2:VERN?    查询返回 Fine 

 

 

10. :CHANnel<n>:INPut 

命令格式：  

:CHANnel<n>:INPut {50OHM|1MOHM} 

:CHANnel<n>:INPut? 

 

功能描述： 

该命令设置和查询通道输入阻抗为 50Ω或 1MΩ。<n>可取 1 或 2。 

 

返回格式：  

查询返回 50ohm 或 1Mohm。 

 

举例： 

:CHAN2:INP 50OHM      设置通道 2 的输入阻抗为 50Ω 

:CHAN2:INP?    查询返回 50ohm 

 

注：该命令仅适于 DS1202CA 和 DS1302CA 数字示波器。 
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MEASure 命令 

 

 

MEASure 命令用于示波器最基本的测量操作，通常以科学计数方式返回所测量结果。 

MEASure 命令包括： 

 :MEASure:CLEar 

 :MEASure:VPP? 

 :MEASure:VMAX? 

 :MEASure:VMIN? 

 :MEASure:VAMPlitude? 

 :MEASure:VTOP? 

 :MEASure:VBASe? 

 :MEASure:VAVerage? 

 :MEASure:VRMS? 

 :MEASure:OVERshoot? 

 :MEASure:PREShoot? 

 :MEASure:FREQuency? 

 :MEASure:RISetime? 

 :MEASure:FALLtime? 

 :MEASure:PERiod? 

 :MEASure:PWIDth? 

 :MEASure:NWIDth? 

 :MEASure:PDUTycycle? 

 :MEASure:NDUTycycle? 

 :MEASure:PDELay? 

 :MEASure:NDELay? 

 :MEASure:TOTal 

 :MEASure:SOURce 

 

下面将详细介绍每条命令的格式、功能和使用方法。 
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1. :MEASure:CLEar  

命令格式： 

:MEASure:CLEar 

 

功能描述： 

该命令用于清除当前测量的参数值。 

 

 

2. :MEASure:VPP? 

命令格式： 

:MEASure:VPP? [<source>] 

 

功能描述： 

该命令用于查询所测波形的峰峰值。 <source>可取 CHANnel1 或 CHANnel2。 

 

返回格式： 

如：6.48e+03，单位为 V。 

 

 

3. :MEASure:VMAX?  

命令格式： 

:MEASure:VMAX? [<source>] 

 

功能描述： 

该命令用于查询所测波形的最大值。<source>可取 CHANnel1 或 CHANnel2。 

 

返回格式： 

如：3.24e+03，单位为 V。 

 

 

4. :MEASure:VMIN? 

命令格式： 

:MEASure:VMIN? [<source>]  

 

功能描述； 

该命令用于查询所测波形的最小值。<source>可取 CHANnel1 或 CHANnel2。 
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返回格式： 

如：-3.24e+03，单位为 V。 

 

 

5. :MEASure:VAMPlitude? 

命令格式： 

:MEASure:VAMPlitude? [<source>]  

 

功能描述： 

该命令用于查询所测波形的幅值。<source>可取 CHANnel1 或 CHANnel2。 

 

返回格式： 

如：6.48e+03，单位为 V。 

 

 

6. :MEASure:VTOP? 

命令格式： 

:MEASure:VTOP? [<source>] 

 

功能描述： 

该命令用于查询所测波形的顶端值。<source>可取 CHANnel1 或 CHANnel2。 

 

返回格式： 

如：3.24e+03，单位为 V。  

 

 

7. :MEASure:VBASe? 

命令格式： 

:MEASure:VBASe? [<source>] 

 

功能描述： 

该命令用于查询所测波形的底端值。<source>可取 CHANnel1 或 CHANnel2。 

 

返回格式： 

如：-3.24e+03，单位为 V。  
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8. :MEASure:VAVerage?   

命令格式： 

:MEASure:VAVerage? [<source>]  

 

功能描述： 

该命令用于查询所测波形的平均值。<source>可取 CHANnel1 或 CHANnel2。 

 

返回格式： 

如：2.67e-01，单位为 V。 

 

 

9. :MEASure:VRMS? 

命令格式： 

:MEASure:VRMS? [<source>] 

 

功能描述： 

该命令用于查询所测波形的均方根值。<source>可取 CHANnel1 或 CHANnel2。 

 

返回格式： 

如：1.36e+06，单位为 V。 

  

 

10. :MEASure:OVERshoot? 

命令格式： 

:MEASure:OVERshoot? [<source>] 

 

功能描述： 

该命令用于查询所测波形的过冲。通常情况下，信号的过冲采用相对于信号幅度

的百分数表示，返回的过冲数值与百分数间的转换关系为：overshoot*100。如；

overshoot = 8.00e3，百分数表示该信号的过冲为 0.8%。 

<source>可取 CHANnel1 或 CHANnel2。 

 

返回格式： 

如：8.00 e-03。  
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11. :MEASure:PREShoot? 

命令格式： 

:MEASure:PREShoot? [<source>]   

 

功能描述： 

该命令用于查询所测波形的预冲。<source>可取 CHANnel1 或 CHANnel2。 

 

返回格式： 

如：8.00 e-03。 

  

 

12. :MEASure:FREQuency? 

命令格式： 

:MEASure:FREQuency? [<source>]  

 

功能描述： 

该命令用于查询所测波形的频率。<source>可取 CHANnel1 或 CHANnel2。 

 

返回格式： 

如：1.00e+03，单位为 Hz。 

  

 

13. :MEASure:RISetime?  

命令格式： 

:MEASure:RISetime? [<source>] 

 

功能描述： 

该命令用于查询所测波形的上升时间。<source>可取 CHANnel1 或 CHANnel2。 

 

返回格式： 

如：3.10e-04，单位为 s。 

  

 

14. :MEASure:FALLtime? 

命令格式： 

:MEASure:FALLtime? [<source>]  
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功能描述： 

该命令用于查询所测波形的下降时间。<source>可取 CHANnel1 或 CHANnel2。 

 

返回格式： 

如：3.10e-04，单位为 s。 

 

 

15. :MEASure:PERiod? 

命令格式： 

:MEASure:PERiod? [<source>]  

 

功能描述： 

该命令用于查询所测波形的周期。<source>可取 CHANnel1 或 CHANnel2。 

 

返回格式： 

如：1.00e-03，单位为 s。 

 

 

16. :MEASure:PWIDth? 

命令格式： 

:MEASure:PWIDth? [<source>]  

 

功能描述： 

该命令用于查询所测波形的正脉宽。<source>可取 CHANnel1 或 CHANnel2。 

 

返回格式： 

如：5.00e-04，单位为 s。 

 

 

17. :MEASure:NWIDth?  

命令格式： 

:MEASure:NWIDth? [<source>]  

 

功能描述： 

该命令用于查询所测波形的负脉宽。<source>可取 CHANnel1 或 CHANnel2。 
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返回格式： 

如：5.00e-04，单位为 s。 

 

 

18. :MEASure:PDUTycycle?  

命令格式： 

:MEASure:PDUTycycle? [<source>]  

 

功能描述： 

该命令用于查询所测波形的正占空比。占空比通常使用百分数表示，返回的数据

与百分比之间的转换关系为：PDUT*100。如：PDUT = 5.00e-1，百分比表示的

占空比为 50%。<source>可取 CHANnel1 或 CHANnel2。 

 

返回格式： 

如；5.00e-01。  

 

 

19. :MEASure:NDUTycycle? 

命令格式： 

:MEASure:NDUTycycle? [<source>] 

 

功能描述：  

该命令用于查询所测波形的负占空比。<source>可取 CHANnel1 或 CHANnel2。 

 

返回格式： 

如：5.00e-01。 

 

 

20. :MEASure:PDELay?  

命令格式： 

:MEASure:PDELay? [<source>]  

 

功能描述： 

该命令用于查询通道 1、2 相对于上升沿的延迟。<source>可取 CHANnel1 或

CHANnel2。 
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返回格式： 

如：<-1.00e-04。 

 

 

21. :MEASure:NDELay? 

命令格式： 

:MEASure:NDELay? [<source>] 

 

功能描述：   

该命令用于查询通道 1、2 相对于下降沿的延迟。<source>可取 CHANnel1 或

CHANnel2。 

 

返回格式： 

如：<-1.00e-04。 

 

 

22. :MEASure:TOTal 

命令格式： 

:MEASure:TOTal {ON|OFF}  

:MEASure:TOTal? 

 

功能描述： 

该命令用于设置和查询全部测量功能的开关状态。 

 

返回格式： 

查询返回 ON 或 OFF。 

 

举例： 

:MEAS:TOT ON   打开全部测量功能 

:MEAS:TOT?            查询返回 ON 

 

 

23. :MEASure:SOURce 

命令格式： 

:MEASure:SOURce <source>  

:MEASure:SOURce?  
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功能描述： 

该命令用于设置和查询当前测量的通道。<source>可取 CHANnel1 或 CHANnel2。 

 

返回格式： 

查询返回 CH1 或 CH2。 

 

举例： 

:MEAS:SOUR CHAN1      选择测量 CH1 的波形     

:MEAS:SOUR?    查询返回 CH1 
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WAVeform 命令 

 

 

WAVeform 命令用于读取示波器中的波形数据。 

WAVeform 命令包括： 

 :WAVeform:DATA? 

 :WAVeform:MEMORYDATA?  

 :WAVeform:POINts:MODE 

 

下面将详细介绍每条命令的格式、功能和使用方法。 
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1. :WAVeform:DATA? 

命令格式： 

:WAVeform:DATA? [<source>]  

 

功能描述： 

该命令用于读取指定源中的波形数据。<source>可取 CHANnel1、CHANnel2、

MATH 或 FFT。 

 

返回格式： 

    当指定源为 CHANnel1、CHANnel2 及 MATH 时，查询返回 600 个数据点。 

    当指定源为 FFT 时， 查询返回 500 个数据点。 

 

 

2. :WAVeform:MEMORYDATA?  

命令格式：  

:WAVeform:MEMORYDATA? [<source>] 

 

功能描述： 

该命令用于读取示波器指定源中的波形数据。 

当示波器处于“STOP”状态时，执行该命令，将读取内存中的数据（半通道*状

态时，读取 10k 个数据，其他情况时，读取 5k 个数据）； 

当示波器处于“RUN”状态时，执行该命令，将读取屏幕中的波形数据。 

<source>可取 CHANnel1 或 CHANnel2。 

注*：半通道是指CH1、CH2中只选一个，MATH关闭且时基小于等于20ns 时的

状态。 

 

返回格式： 

查询返回读取的数据。 

 

 

3. :WAVeform:POINts:MODE 

命令格式： 

:WAVeform:POINts:MODE <points_mode> 

:WAVeform:POINts:MODE? 

 

功能描述： 
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该命令用于设置波形点模式。<points_mode>可设置为 NORMal、MAXimum 或 

RAW。 

 

:WAVeform:DATA?命令在不同模式下返回的波形点数： 
 

 NORMal RAW MAX 

MATH 600 600 运行状态时， 

与 NORMal 相同， 

停止状态时，与 RAW

相同。 

FFT 500 500 

CHx 600 5120 

半通道 CHx 600 10240 

 

返回格式： 

查询返回 NORMal、RAW 或 MAXimum。 

 

举例： 

:WAV:POIN:MODE NORM        设置波形点模式为 NORMal。 

:WAV:POIN:MODE?              查询返回 NORMal。 
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KEY 命令 

 

 

KEY 命令用于控制 DS1000CA 面板上的按键和旋钮。 

KEY 命令包括： 

 :KEY:LOCK 

 :KEY:RUN 

 :KEY:AUTO 

 :KEY:CHANnel1 

 :KEY:CHANnel2 

 :KEY:MATH 

 :KEY:REF 

 :KEY:F1 

 :KEY:F2 

 :KEY:F3 

 :KEY:F4 

 :KEY:F5 

 :KEY:MNUoff 

 :KEY:MEASure 

 :KEY:CURSor 

 :KEY:ACQuire 

 :KEY:DISPlay 

 :KEY:STORage 

 :KEY:UTILity 

 :KEY:MNUTIME 

 :KEY:MNUTRIG 

 :KEY:Trig%50 

 :KEY:FORCe 

 :KEY:V_POS_INC 

 :KEY:V_POS_DEC 

 :KEY:V_SCALE_INC 

 :KEY:V_SCALE_DEC 

 :KEY:H_SCALE_INC 

 :KEY:H_SCALE_DEC 

 :KEY:TRIG_LVL_INC 

 :KEY:TRIG_LVL_DEC 

 :KEY:H_POS_INC 

 :KEY:H_POS_DEC 

 :KEY:PROMPT_V 

 :KEY:PROMPT_H 

 :KEY:FUNCtion 

 :KEY:+FUNCtion 

 :KEY:-FUNCtion 

 :KEY:PROMPT_V_POS 

 :KEY:PROMPT_H_POS 

 :KEY:PROMPT_TRIG_LVL 

 :KEY:OFF 

 

下面将详细介绍每条命令的格式、功能和使用方法。 
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1. :KEY:LOCK 

命令格式： 

:KEY:LOCK {ENABle|DISable} 

:KEY:LOCK? 

 

功能描述： 

该命令用于开启/禁用远程控制前面板按键的功能。 

 

返回格式： 

查询返回 ENABLE 或 DISABLE。 

 

举例： 

:KEY:LOCK ENAB     开启远程控制前面板按键的功能 

:KEY:LOCK?     查询返回 ENABLE 

 

 

2. :KEY:RUN    

命令格式： 

:KEY:RUN 

 

功能描述： 

该命令用于控制示波器的运行状态，连续发送该命令，示波器将在停止和运行状

态间切换。  

 

 

3. :KEY:AUTO 

命令格式： 

:KEY:AUTO  

 

功能描述： 

该命令用于自动设定示波器的各项控制值，以产生适宜观察的波形显示。 

 

 

4. :KEY:CHANnel1  

命令格式： 

:KEY:CHANnel1 
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功能描述： 

该命令用于开启/关闭通道 1 及其菜单显示。连续发送该命令，可切换开关状态。  

 

 

5. :KEY:CHANnel2   

命令格式： 

:KEY:CHANnel2 

 

功能描述： 

该命令用于开启/关闭通道 2 及其菜单显示。连续发送该命令，可切换开关状态。  

 

 

6. :KEY:MATH 

命令格式： 

:KEY:MATH 

 

功能描述： 

该命令用于开启/关闭 MATH 功能及其菜单显示。连续发送该命令，可切换开关状

态。 

 

 

7. :KEY:REF   

命令格式： 

:KEY:REF 

 

功能描述： 

该命令用于开启/关闭波形参考功能及其菜单显示。连续发送该命令，可切换开关

状态。  

  

 

8. :KEY:F1 

命令格式： 

:KEY:F1 

 

功能描述： 

该命令用于控制 F1 按键所对应的菜单选项。若设有下级菜单，通过连续发送该
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命令，可以循环选择下级菜单中的其他选项。 

 

 

9. :KEY:F2 

命令格式： 

:KEY:F2 

 

功能描述： 

该命令用于控制 F2 按键所对应的菜单选项。若设有下级菜单，通过连续发送该

命令，可以循环选择下级菜单中的其他选项。 

 

 

10. :KEY:F3 

命令格式： 

:KEY:F3 

 

功能描述： 

该命令用于控制 F3 按键所对应的菜单选项。若设有下级菜单，通过连续发送该

命令，可以循环选择下级菜单中的其他选项。 

 

 

11. :KEY:F4 

命令格式： 

:KEY:F4 

 

功能描述： 

该命令用于控制 F4 按键所对应的菜单选项。若设有下级菜单，通过连续发送该

命令，可以循环选择下级菜单中的其他选项。 

 

 

12. :KEY:F5 

命令格式： 

:KEY:F5 

 

功能描述： 

该命令用于控制 F5 按键所对应的菜单选项。若设有下级菜单，通过连续发送该
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命令，可以循环选择下级菜单中的其他选项。 

 

 

13. :KEY:MNUoff  

命令格式： 

:KEY:MNUoff 

 

功能描述； 

该命令用于开启/关闭当前菜单显示。连续发送该命令，可切换开关状态。 

 

 

14. :KEY:MEASure  

命令格式： 

:KEY:MEASure 

 

功能描述： 

该命令用于开启/关闭测量功能及其菜单显示。连续发送该命令，可切换开关状态。 

 

 

15. :KEY:CURSor 

命令格式： 

:KEY:CURSor 

 

功能描述： 

该命令用于开启/关闭光标测量功能及其菜单显示，连续发送该命令，可在关闭、

手动、追踪和自动测量四种光标模式之间进行切换。 

 

 

16. :KEY:ACQuire 

命令格式： 

:KEY:ACQuire  

 

功能描述： 

该命令用于开启/关闭采样功能及其菜单显示。连续发送该命令，可切换开关状态。 
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17. :KEY:DISPlay   

命令格式： 

:KEY:DISPlay  

 

功能描述： 

该命令用于开启/关闭显示功能及其菜单显示。连续发送该命令，可切换开关状态。

  

 

18. :KEY:STORage  

     命令格式： 

:KEY:STORage  

 

功能描述： 

该命令用于开启/关闭存储功能及其菜单显示。连续发送该命令，可切换开关状态。 

 

 

19. :KEY:UTILity  

    命令格式： 

:KEY:UTILity 

 

    功能描述： 

该命令用于开启/关闭辅助功能及其菜单显示。连续发送该命令，可切换开关状态。 

 

 

20. :KEY:MNUTIME  

命令格式： 

:KEY:MNUTIME 

 

功能描述： 

该命令用于开启/关闭水平系统及其菜单显示。连续发送该命令，可切换开关状态。

  

  

21. :KEY:MNUTRIG  

命令格式： 

:KEY:MNUTRIG  
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功能描述； 

该命令用于开启/关闭触发功能及其菜单显示。连续发送该命令，可切换开关状态。 

 

 

22. :KEY:Trig%50 

命令格式： 

:KEY:Trig%50  

 

功能描述； 

该命令用于设定触发电平值至信号幅值的垂直中点。 

  

 

23. :KEY:FORCe   

命令格式： 

:KEY:FORCe 

 

功能描述：  

该命令用于解除远程控制的锁定状态。 

 

 

24. :KEY:V_POS_INC 

命令格式： 

:KEY:V_POS_INC 

 

功能描述： 

该命令以均匀步进增加当前通道的垂直位移。 

 

 

25. :KEY:V_POS_DEC 

命令格式： 

:KEY:V_POS_DEC 

 

功能描述： 

该命令以均匀步进减少当前通道的垂直位移。 
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26. :KEY:V_SCALE_INC 

命令格式： 

:KEY:V_SCALE_INC 

 

功能描述： 

该命令以 1-2-5 为步进增加当前通道的垂直档位。 

 

 

27. :KEY:V_SCALE_DEC 

命令格式： 

:KEY:V_SCALE_DEC 

 

功能描述： 

该命令以 5-2-1 为步进减少当前通道的垂直档位。 

 

 

28. :KEY:H_SCALE_INC 

命令格式： 

:KEY:H_SCALE_INC 

 

功能描述；  

该命令以 5-2-1 为步进减少当前通道的水平档位。 

 

 

29. :KEY:H_SCALE_DEC 

命令格式： 

:KEY:H_SCALE_DEC 

 

功能描述；  

该命令以 1-2-5 为步进增加当前通道的水平档位。 

 

 

30. :KEY:TRIG_LVL_INC 

命令格式： 

:KEY:TRIG_LVL_INC 
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功能描述： 

该命令以均匀步进增加触发电平值。 

 

 

31. :KEY:TRIG_LVL_DEC 

命令格式： 

:KEY:TRIG_LVL_DEC 

 

功能描述： 

该命令以均匀步进减少触发电平值。 

 

 

32. :KEY:H_POS_INC 

命令格式： 

:KEY:H_POS_INC 

 

功能描述； 

该命令以均匀步进增加当前通道的水平位移。 

 

 

33. :KEY:H_POS_DEC 

命令格式： 

:KEY:H_POS_DEC 

 

功能描述： 

该命令以均匀步进减少当前通道的水平位移。 

 

 

34. :KEY:PROMPT_V 

命令格式： 

:KEY:PROMPT_V 

 

功能描述： 

该命令用于切换垂直档位的粗调/微调方式。粗调以 1-2-5 步进，微调以均匀间隔

步进。 
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35. :KEY:PROMPT_H 

命令格式： 

:KEY:PROMPT_H 

 

功能描述： 

该命令用于开启/关闭延迟扫描功能。连续发送该命令，可切换开关状态。 

 

 

36. :KEY:FUNCtion 

命令格式： 

:KEY:FUNCtion 

 

功能描述： 

该命令用于按下多功能旋钮。 

 

 

37. :KEY:+FUNCtion 

命令格式： 

:KEY:+FUNCtion 

 

功能描述： 

该命令用于增加多功能旋钮的位移。 

 

 

38. :KEY:-FUNCtion 

命令格式： 

:KEY:-FUNCtion 

 

功能描述： 

该命令用于减少多功能旋钮的位移。 

 

 

39. :KEY:PROMPT_V_POS 

命令格式： 

:KEY:PROMPT_V_POS 
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功能描述： 

该命令用于将通道的垂直位移恢复至零点。 

 

 

40. :KEY:PROMPT_H_POS 

命令格式： 

:KEY:PROMPT_H_POS 

 

功能描述； 

该命令用于将触发位移（或延迟扫描位移）恢复至零点。 

 

 

41. :KEY:PROMPT_TRIG_LVL 

命令格式： 

:KEY:PROMPT_TRIG_LVL 

 

功能描述： 

该命令用于将触发电平恢复至屏幕中心位置。 

 

 

42. :KEY:OFF 

命令格式： 

:KEY:OFF 

 

功能描述： 

连续发送该命令，将逐个关闭 CH1、CH2、MATH 和 REF 按键。 
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CURSor 命令 

 

 

CURSor 命令用于设置光标参数，对屏幕波形数据进行手动、追踪和自动测量。 

CURSor 命令包括： 

 :CURSor:MODE 

 :CURSor:MANUal:TYPE 

 :CURSor:MANUal:SOURce 

 :CURSor:MANUal:CURAX 

 :CURSor:MANUal:CURAY 

 :CURSor:MANUal:CURBX 

 :CURSor:MANUal:CURBY 

 :CURSor:TRACk:SOURceA 

 :CURSor:TRACk:SOURceB 

 :CURSor:TRACk:CURA 

 :CURSor:TRACk:CURB 

 :CURSor:TRACk:CURAY? 

 :CURSor:TRACk:CURBY? 

 

下面将详细介绍每条命令的格式、功能和使用方法。 
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1. :CURSor:MODE 

命令格式：  

:CURSor:MODE {CLOSe|MANUal|TRACk|MEASure} 

:CURSor:MODE? 

 

功能描述：  

该命令用于设置和查询系统的光标模式为 CLOSe（关闭）、MANUal（手动）、TRACk

（追踪）或 MEASure（自动测量）。 

 

返回格式：  

查询返回光标模式，CLOSe、MANUal、TRACk 或 MEASure。 

 

举例： 

:CURS:MODE TRAC   设置光标模式为追踪 

:CURS:MODE?    查询返回 TRACk 

 

 

2. :CURSor:MANUal:TYPE 

命令格式：  

:CURSor:MANUal:TYPE {TIME|AMPlitude} 

:CURSor:MANUal:TYPE? 

 

功能描述： 

该命令用于设置和查询手动光标模式下的光标类型为 TIME（时间）或 AMPlitude

（幅度）。 

 

返回格式：  

查询返回手动光标模式的光标类型，TIME 或 AMPlitude。 

 

举例： 

:CURS:MANU:TYPE TIME    设置手动光标模式的光标类型为时间 

:CURS:MANU:TYPE?     查询返回 TIME 

 

 

3. :CURSor:MANUal:SOURce 

命令格式：  
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:CURSor:MANUal:SOURce <source> 

:CURSor:MANUal:SOURce? 

 

功能描述： 

该命令用于设置和查询使用手动光标模式时的信源，其中<source>可取

CHANnel1、CHANnel2 或 MATH。 

 

返回格式：  

查询返回 CHANnel1、CHANnel2 或 MATH。 

 

举例： 

:CURS:MANU:SOUR CHAN1  设置使用手动光标模式的光标源为通道 1 

:CURS:MANU:SOUR?    查询返回 CHANnel1 

 

 

4. :CURSor:MANUal:CURAX 

命令格式：  

:CURSor:MANUal:CURAX <value> 

:CURSor:MANUal:CURAX? 

 

功能描述： 

该命令用于设置和查询手动模式下光标 AX 的位置，其中<value>的取值范围为

4~297。 

 

返回格式：  

查询返回 value 的设置值。 

 

举例： 

:CURS:MANU:CURAX 100    设置手动光标的 AX 位置为 100 

:CURS:MANU:CURAX?    查询返回 100 

 

 

5. :CURSor:MANUal:CURAY 

命令格式：  

:CURSor:MANUal:CURAY <value> 

:CURSor:MANUal:CURAY? 
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功能描述： 

该命令用于设置和查询手动模式下光标 AY 的位置，其中<value>的取值范围为

4~194。 

 

返回格式：  

查询返回 value 的设置值。 

 

举例： 

:CURS:MANU:CURAY 100    设置手动光标的 AY 位置为 100 

:CURS:MANU:CURAY?    查询返 100 

 

 

6. :CURSor:MANUal:CURBX 

命令格式：  

:CURSor:MANUal:CURBX <value> 

:CURSor:MANUal:CURBX? 

 

功能描述： 

该命令用于设置和查询手动模式下光标 BX 的位置，其中<value>的取值范围为

4~297。 

 

返回格式：  

查询返回 value 的设置值。 

 

举例： 

:CURS:MANU:CURBX 100    设置手动光标的 BX 位置为 100 

:CURS:MANU:CURBX?    查询返回 100 

 

 

7. :CURSor:MANUal:CURBY 

命令格式： 

:CURSor:MANUal:CURBY <value> 

:CURSor:MANUal:CURBY? 

 

功能描述： 

该命令用于设置和查询手动模式下光标 BY 的位置，其中<value>的取值范围为

4~194。 
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返回格式：  

查询返回 value 的设置值。 

 

举例： 

:CURS:MANU:CURBY 100    设置手动光标的 BY 位置为 100 

:CURS:MANU:CURBY?    查询返回 100 

 

 

8. :CURSor:TRACk:SOURceA 

命令格式：  

:CURSor:TRACk:SOURceA <source> 

:CURSor:TRACk:SOURceA? 

 

功能描述： 

该命令用于设置和查询追踪模式下光标 A 追踪的测量通道。其中<source>可取

CHANnel1、CHANnel2、MATH 或 NONE。 

 

返回格式：  

查询返回 CHANnel1、CHANnel2、MATH 或 NONE。 

 

举例： 

:CURS:TRAC:SOURA CHAN1   设置光标 A 追踪的测量通道为 CHANnel1 

:CURS:TRAC:SOURA?    查询返回 CHANnel1 

 

 

9. :CURSor:TRACk:SOURceB 

命令格式： 

:CURSor:TRACk:SOURceB <source> 

:CURSor:TRACk:SOURceB? 

 

功能描述： 

该命令用于设置和查询追踪模式下光标 B 追踪的测量通道，其中<source>可取

CHANnel1、CHANnel2、MATH 或 NONE。 

 

返回格式：  

查询返回 CHANnel1、CHANnel2、MATH 或 NONE。 
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举例： 

:CURS:TRAC:SOURB CHAN1   设置光标 B 追踪的测量通道为 CHANnel1 

:CURS:TRAC:SOURB?    查询返回 Channel1 

 

 

10. :CURSor:TRACk:CURA 

命令格式：  

:CURSor:TRACk:CURA <value> 

:CURSor:TRACk:CURA? 

 

功能描述： 

该命令用于设置和查询追踪模式下光标 A 的位置，<value>的取值范围为 4~297。 

 

返回格式：  

查询返回追踪光标 A 的位置。 

 

举例： 

:CURS:TRAC:CURA 100   设置追踪光标 A 的位置为 100 

:CURS:TRAC:CURA?    查询返回 100 

 

 

11. :CURSor:TRACk:CURB 

命令格式：  

:CURSor:TRACk:CURB <value> 

:CURSor:TRACk:CURB? 

 

功能描述： 

该命令用于设置和查询追踪模式下光标 B 的位置，<value>的取值范围为 4~297。 

 

返回格式：  

查询返回追踪光标 B 的位置。 

 

举例： 

:CURS:TRAC:CURB 100   设置追踪光标 B 的位置为 100 

:CURS:TRAC:CURB?    查询返回 100 
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12. :CURSor:TRACk:CURAY? 

命令格式： 

:CURSor:TRACk:CURAY? 

 

功能描述： 

该命令用于查询追踪模式下光标 AY 的位置。 

 

返回格式： 

查询返回 AY 的位置，范围为 4~194。 

 

 

13. :CURSor:TRACk:CURBY? 

命令格式： 

:CURSor:TRACk:CURBY? 

 

功能描述： 

该命令用于查询追踪模式下光标 BY 的位置。 

 

返回格式： 

查询返回 BY 的位置，范围为 4~194。 
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其他命令 

 

 

除了上述用于控制示波器基本操作的命令外，还有一些用于控制系统语言、频率计和

蜂鸣器的命令，包括： 

 :INFO:LANGuage 

 :COUNter:ENABle 

 :BEEP:ENABle 

 :BEEP:ACTion 

 

下面将详细介绍每条命令的格式、功能和使用方法。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



RIGOL 命令系统 

 

  
DS1000CA 系列数字示波器编程手册 2-84 

1. :INFO:LANGuage 

命令格式： 

:INFO:LANGuage <lang> 

:INFO:LANGuage? 

 

功能描述： 

该命令用于设置和查询系统语言。<lang>可取 SIMPlifiedchinese（简体中文）、 

TRADitionalchinese（繁体中文）、ENGLish（英文）、KORean（韩语）、JAPanese

（日本语）、FRENch（法语）、GERMan（德语）、RUSSian（俄语）、SPANish（西

班牙语）或 PORTuguese（葡萄牙语）。 

 

返回格式：  

查询返回 lang 的设置值：Simplified Chinese、Traditional Chinese、English、

Korean、Japanese、French、German、Russian、Spanish 或 Portuguese。 

 

举例： 

:INFO:LANG SIMP      设置系统语言为简体中文 

:INFO:LANG?      查询返回 Simplified Chinese   

 

 

2. :COUNter:ENABle 

命令格式： 

:COUNter:ENABle {ON|OFF}  

:COUNter:ENABle? 

 

功能描述： 

该命令用于设置和查询示波器频率计功能的开关状态。 

 

返回格式：  

查询返回 ON 或 OFF。 

 

举例： 

:COUN:ENAB ON       打开频率计功能 

:COUN:ENAB?      查询返回 ON 

 

 

3. :BEEP:ENABle 
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命令格式： 

:BEEP:ENABle {ON|OFF}  

:BEEP:ENABle?  

 

功能描述： 

该命令用于设置和查询蜂鸣器的开关状态。 

 

返回格式：  

查询返回 ON 或 OFF。 

 

举例： 

:BEEP:ENAB ON       打开蜂鸣器 

:BEEP:ENAB?       查询返回 ON 

 

 

4. :BEEP:ACTion 

命令格式： 

:BEEP:ACTion 

 

功能描述： 

该命令用于产生一次蜂鸣（无论蜂鸣器是否打开）。 
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第3章 编程实例 
 

 

本章例举了在 Visual C++ 6.0，Visual Basic 6.0 和 LabVIEW 8.2 开发环境中如何使用

命令实现示波器常用功能的编程实例。这些实例都是基于 VISA（Virtual Instrument 

Software Architecture）库编程实现的。 

 

VISA 是一个用于控制仪器的应用程序编程接口，它使用户可以方便地开发与仪器、接

口类型无关的测试应用。请注意，这里所说的 VISA 指的是 NI（National Instrument）

-VISA。NI-VISA 是美国国家仪器有限公司根据 VISA 标准编写的应用程序接口。您可

以使用 NI-VISA 通过 USB 以及 RS232 等仪器总线实现示波器与 PC 的通信。VISA 定

义了一套软件命令，用户无需了解接口总线如何工作，就可以对仪器进行控制。具体

细节可参考 NI-VISA 的帮助。 

一个典型的 VISA 应用分为以下几个步骤： 

1. 为已有的资源建立会话 

2. 对资源做一些配置（如波特率） 

3. 关闭会话资源 
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编程准备 

 

首先确认您的电脑上是否已经安装 NI 的 VISA 库（可到 NI 网站

http://www.ni.com/china 下载）。本文中默认安装路径为 C:\Program Files\IVI 

Foundation\VISA。 

 

DS1000CA 系列数字示波器可通过 USB 或 RS232 接口与 PC 实现通讯： 

 

1. RS232 串口连接 

使用 RS232 电缆将示波器后面板的 RS232 串口与 PC 相连。 

 

2. USB 连接 

使用 USB 数据线将示波器后面板的 USB Device 接口与 PC 相连。示波器与 PC 正

确连接后，接通仪器电源，此时 PC 上将弹出“硬件更新向导”对话框，请按照

向导的提示安装“USB Test and Measurement Device”。 

 

至此，编程准备工作到此结束。以下为您详细介绍在 Visual C++ 6.0、Visual Basic 

6.0 以及 LabVIEW 8.2 开发环境中的编程实例（前三个实例用 USB 接口通讯，第

四个实例采用 RS232 接口通讯）。 

 

 

http://digital.ni.com/worldwide/china.nsf/main?readform
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Visual C++ 6.0 编程实例 

 

进入 Visual C++6.0 编程环境，按照下列步骤操作： 

1. 建立一个基于 MFC 的工程。 

2. 打开 Project→Settings 中的 C/C++选项卡，在 Category 中选 Code Generation，

在 Use run-time library 中选 Debug Multithreaded DLL。点 OK 关闭对话框。 

 
 

3. 打开 Project→Settings 中的 Link 选项卡，在 Object/library modules 中手动添加

visa32.lib。 
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4. 打开 Tools→Options 中的 Directories 选项卡。 

在 Show directories for 中选择 Include files，双击 Directories 选框中的空白处添

加 Include 的路径：C:\Program Files\IVI Foundation\VISA\WinNT\include。 

在 Show directories for 中选择 Library files，双击 Directories 选框中的空白处添

加 Lib 的路径：C:\Program Files\IVI Foundation\VISA\WinNT\lib\msc。 

 

注：至此，VISA 库添加完毕。 

 

5. 添加控件 Text，Com box，Button 及 Edit，得到下图所示界面： 

 

 

 

空白处 
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6. 修改控件属性。 

(1) 将 Text 命名为“Command”。 

(2) 打开 Com box 属性中的 Data 项，手动输入三个命令： 

*IDN? 

*OPC? 

:ACQuire:TYPE? 

(3) 打开 Edit 属性中的 General 项，选中 Disable。 

(4) 将 Button 命名为 Send and Read。 

 

7. 为 Com box 和 Edit 控件分别添加变量 m_combox 和 m_receive。 
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8. 添加代码。 

双击“Send and Read”进入编程环境，首先请在头文件中对 visa 库“#include  

<visa.h>”进行声明，然后添加如下代码： 

ViSession defaultRM, vi; 

 char buf [256] = {0}; 

 CString s,strTemp; 

 char* stringTemp;  

 

 ViChar buffer [VI_FIND_BUFLEN]; 

 ViRsrc matches=buffer; 

 ViUInt32 nmatches; 

 ViFindList list; 

 

 viOpenDefaultRM (&defaultRM); 

 

 //获取 visa 的 USB 资源 

 viFindRsrc(defaultRM, "USB?*", &list,&nmatches, matches); 

 viOpen (defaultRM,matches,VI_NULL,VI_NULL,&vi);  

 viPrintf (vi, "*RST\n"); 

 

 //发送接收到的命令 
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    m_combox.GetLBText(m_combox.GetCurSel(),strTemp);  

 strTemp = strTemp + "\n"; 

    stringTemp = (char *)(LPCTSTR)strTemp;   

viPrintf (vi,stringTemp); 

 

 //读取结果 

 viScanf (vi, "%t\n", &buf); 

 

    //将结果显示出来 

 UpdateData (TRUE);   

 m_receive = buf; 

 UpdateData (FALSE); 

 viClose (vi); 

 viClose (defaultRM); 

 

9. 保存、编译和运行工程，可得到单个可执行文件。当示波器与 PC 成功相连时，

选择一条命令如*IDN?，按“Send and Read”按键，将显示示波器返回的结果。 
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Visual Basic 6.0 编程实例 

 

进入 Visual Basic 6.0 编程环境，按照下列步骤操作： 

1. 建立一个 Standard EXE 工程。 

2. 打开 Project→Add Module 的 Existing 选项卡，找到之前 NI-VISA 安装路径下的

include 文件夹中的 visa.bas 文件并添加。 

 

 

3. 在 Demo 中添加如下两个按钮，分别代表 CH1 和 CH2。添加两个 Label：Label1(0)

和 Label1(1)，使其分别显示 CH1 和 CH2 的状态（打开时显示通道的颜色，关闭

时显示成灰色）。如下图所示： 

 

4. 打开 Project→Project1 Properties 中的 General 选项卡，在 Startup Object 下拉

框中选择 Form1。 
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5. 双击 CH1 按钮进入编程环境，添加如下代码，即可实现对 CH1 和 CH2 的控制。

以下为 CH1 的代码，CH2 代码类似。 

   Dim defrm As Long 

   Dim vi As Long 

   Dim strRes As String * 200 

   Dim list As Long 

   Dim nmatches As Long 

   Dim matches As String * 200 '保留获取设备号 

   ' 获得 visa 的 usb 资源 

   Call viOpenDefaultRM(defrm) 

   Call viFindRsrc(defrm, "USB?*", list, nmatches, matches) 

   ' 打开设备 

   Call viOpen(defrm, matches, 0, 0, vi)       

   ' 发送询问 CH1 状态命令 

   Call viVPrintf(vi, ":CHAN1:DISP?" + Chr$(10), 0)    

   ' 获取 CH1 状态 

   Call viVScanf(vi, "%t", strRes)    

   If strRes = 1 Then          

   ' 发送设置命令 

   Call viVPrintf(vi, ":CHAN1:DISP 0" + Chr$(10), 0) 

   Label1(0).ForeColor = &H808080  '灰色    

   Else    

   Call viVPrintf(vi, ":CHAN1:DISP 1" + Chr$(10), 0) 

   Label1(0).ForeColor = &HFFFF&  '黄色    

   End If        

   ' 关闭资源 

   Call viClose(vi) 

   Call viClose(defrm) 

6. 保存、运行整个工程，可得到 demo 的单个可执行程序。当示波器与 PC 成功相

连时，可实现对任意一个通道的开/关控制。 
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LabVIEW 8.2 编程实例 

 

进入 LabVIEW 8.2 开发环境，按照下列步骤操作： 

1. 打开 LabVIEW，进入程序框图面板，从仪器 I/O→VISA 中分别添加四个函数：

“VISA 打开”，“VISA 读取”，“VISA 写入”以及“VISA 关闭”： 

 

 

2. 将鼠标移动至“VISA 打开”控件的“VISA 资源名称”项目上，点击右键，选择

创建→输入控件。完成后如图所示： 
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3. 将所有函数的“VISA 资源名称”和“VISA 资源名称输出”连接，“错误输出”和

“错误输入连接”： 

 

 

4. 在 “VISA 写入”控件的“写入缓冲区”上添加文本框，写入：“:WAV:DATA?\n”，

用来读取屏幕波形数据。 
 

 

 

5. 打开 LabVIEW 前面板，从新式→图形→波形图中添加一个波形图控件： 

 

 

6. 打开 LabVIEW 程序框图，点击右键，在“编程”→“字符串”→“字符串/数组/

路径转换”中选择一个“字符串至字节数组字符转换”函数，用其将刚刚创建的

波形图与“VISA 读取”函数中的“读取缓冲区”连接起来。 
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7. 增加一个事件结构和一个 While 循环，并添加两个按钮，一个用来控制开始捕捉

波形，一个用来停止程序，完成后如图所示： 
 

 

 

8. 在“选择器标签”上点击右键，选择“编辑事件分支”或者“添加事件分支”，分

别为按钮添加事件，“开始”进行波形捕捉，“停止”退出程序： 
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“开始捕捉”事件设置好之后如下图所示： 

 

 

 

9. 为程序增加一个 While 循环，并增添一个“布尔”→“真常量”将“程序停止”

按钮的事件指向 While 退出*： 

 

注*：波形数据含有数据头#8xxxxxxxx 共 10 个字节, 然后才是波形数据点, 所以

程序中先读取 10 个字节,然后再读取波新数据 600 点。 
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10. 将 While 循环上的 VISA 资源名输入和错误输入更改成“移位寄存器”，程序的制

作就此结束： 

 

 

11. 调整前面板的样式，点击“捕捉波形”后可得到如下界面（示波器已正确连接）： 
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Visual C++ 6.0 串口编程实例 

 

进入 Visual C++6.0 编程环境，按照下列步骤操作： 

1. 建立一个基于 MFC 的工程。 

2. 打开 Project→Settings 中的 C/C++选项卡，在 Category 中选 Code Generation，

在 Use run-time library 中选 Debug Multithreaded DLL。点 OK 关闭对话框。 

 
 

3. 打开 Project->Settings 中的 Link 选项卡，在 Object/library modules 中手动添加

visa32.lib。 
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4. 打开 Tools→Options 中的 Directories 选项卡。 

在 Show directories for 中选择 Include files，双击 Directories 选框中的空白处添

加 Include 的路径：C:\Program Files\IVI Foundation\VISA\WinNT\include。 

在 Show directories for 中选择 Library files，双击 Directories 选框中的空白处添

加 Lib 的路径：C:\Program Files\IVI Foundation\VISA\WinNT\lib\msc。 

 

注：至此，VISA 库添加完毕。 

 

5. 添加控件 Text，Com box，Button 及 Edit，得到下图所示界面： 

 

 

空白处 
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6. 修改控件属性。 

(1) 将 Text 命名为“Command”。 

(2) 打开 Com box 属性中的 Data 项，手动输入三个命令： 

*IDN? 

:MEAS:VPP? 

:ACQuire:TYPE? 

(3) 打开 Edit 属性中的 General 项，选中 Disable。 

(4) 将 Button 命名为 Send and Read。 

 

7. 为 Com box 和 Edit 控件分别添加变量 m_combox 和 m_receive。 
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8. 添加代码*。 

双击“Send and Read”进入编程环境，首先请在头文件中对 visa 库“#include  

<visa.h>”进行声明，然后添加如下代码： 

 ViSession defaultRM, vi; 

 char buf [256] = {0}; 

 CString s,strTemp; 

 char* stringTemp; 

    unsigned long retCount;  

 

 ViChar buffer [VI_FIND_BUFLEN]; 

 ViRsrc matches=buffer; 

 ViUInt32 nmatches; 

 ViFindList list; 

     

    //1.打开设备管理器 

 viOpenDefaultRM (&defaultRM); 

 

 //2.获取 visa 的串口资源 

 viFindRsrc(defaultRM, "ASRL?*", &list,&nmatches, matches); 

 //打开串口设备 

    viOpen (defaultRM,matches,VI_NULL,VI_NULL,&vi);  

    //4.设置串口总线属性 
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    viSetAttribute (vi, VI_ATTR_TMO_VALUE, 5000); 

    viSetAttribute (vi, VI_ATTR_TERMCHAR, 0xA); 

    viSetAttribute (vi, VI_ATTR_TERMCHAR_EN, VI_TRUE); 

     

    //5.设置串口波特率,停止位等 

    viSetAttribute (vi, VI_ATTR_ASRL_BAUD, 9600);                  //波特率 

    viSetAttribute (vi, VI_ATTR_ASRL_DATA_BITS, 8);                //数据位数 

    viSetAttribute (vi, VI_ATTR_ASRL_STOP_BITS, VI_ASRL_STOP_ONE); //停止位 

    viSetAttribute (vi, VI_ATTR_ASRL_PARITY, VI_ASRL_PAR_NONE);     //无校验 

 

 

 //发送接收到的命令 

    m_combox.GetLBText(m_combox.GetCurSel(),strTemp);  

    

    sprintf( buf,"%s\n",strTemp.GetBuffer(10)); 

    viWrite( vi, (unsigned char*)(&buf), strTemp.GetLength()+1, &retCount ); 

 

 //读取结果 

    viScanf(vi,"%t\n",&buf ); 

 

 m_receive = buf; 

 

 UpdateData (FALSE); 

 

 viClose (vi); 

 viClose (defaultRM); 

9. 保存、编译和运行工程，可得到单个可执行文件。当示波器与 PC 成功相连时，

选择一条命令如*IDN?，按“Send and Read”按键，将显示示波器返回的结果。 

说明*： 

采用串口通讯时，请注意以下几点： 

(1) 由于串口通讯速度较低，在使用串口传输数据时需要设置合适的总线超时时间，

以避免通讯错误。 

(2) 串口通讯设置包括波特率、数据位数、停止位和奇偶校验，且必须与示波器设置

相同，否则通讯失败。 

(3) 使用串口读取数据过程中，当 VISA 遇到数据流中的结束符 0x0A 时，系统读取数

据结束。因此，出现 0x0A 时需要特别注意这种截断。可以通过读取的数据长度

来判定是否接收完数据。
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附录 命令速查 A~Z 

 

 

 

*IDN?  2-3 

*RST  2-3 

A 

:AUTO  2-5 

:ACQuire:TYPE  2-7 

:ACQuire:MODE  2-7 

:ACQuire:AVERages  2-7 

:ACQuire:SAMPlingrate?  2-8 

B 

:BEEP:ENABle  2-84 

:BEEP:ACTion  2-85 

C 

:CHANnel<n>:BWLimit  2-48 

:CHANnel<n>:COUPling  2-48 

:CHANnel<n>:DISPlay  2-48 

:CHANnel<n>:INVert  2-49 

:CHANnel<n>:OFFSet  2-49 

:CHANnel<n>:PROBe  2-50 

:CHANnel<n>:SCALe  2-50 

:CHANnel<n>:FILTer  2-51 

:CHANnel<n>:VERNier  2-51 

:CHANnel<n>:INPut  2-52 

:CURSor:MODE  2-77 

:CURSor:MANUal:TYPE  2-77 

:CURSor:MANUal:SOURce  2-77 

:CURSor:MANUal:CURAX  2-78 

:CURSor:MANUal:CURAY  2-78 

:CURSor:MANUal:CURBX  2-79 

:CURSor:MANUal:CURBY  2-79 

:CURSor:TRACk:SOURceA  2-80 

:CURSor:TRACk:SOURceB  2-80 

:CURSor:TRACk:CURA  2-81 

:CURSor:TRACk:CURB  2-81  

:CURSor:TRACk:CURAY?  2-82 

:CURSor:TRACk:CURBY?  2-82 

:COUNter:ENABle  2-84 

D 

:DISPlay:TYPE  2-10 

:DISPlay:GRID  2-10 

:DISPlay:PERSist  2-10 

:DISPlay:MNUDisplay  2-11 

:DISPlay:MNUStatus  2-11 

:DISPlay:CLEar  2-12 

:DISPlay:BRIGhtness  2-12 

:DISPlay:INTensity  2-12 

:DISPlay:SCReen  2-13 

F 

:FORCetrig  2-23 

:FFT:DISPlay  2-45 

H 

:HARDcopy  2-5 

I 

:INFO:LANGuage  2-84 

K 

:KEY:LOCK  2-66 

:KEY:RUN  2-66 

:KEY:AUTO  2-66 

:KEY:CHANnel1  2-66 

:KEY:CHANnel2  2-67 

:KEY:MATH  2-67 
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:KEY:REF  2-67 

:KEY:F1  2-67 

:KEY:F2  2-68 

:KEY:F3  2-68 

:KEY:F4  2-68 

:KEY:F5  2-68 

:KEY:MNUoff  2-69 

:KEY:MEASure  2-69 

:KEY:CURSor  2-69 

:KEY:ACQuire  2-69 

:KEY:DISPlay  2-70 

:KEY:STORage  2-70 

:KEY:UTILity  2-70 

:KEY:MNUTIME  2-70 

:KEY:MNUTRIG  2-70 

:KEY:Trig%50  2-71 

:KEY:FORCe  2-71 

:KEY:V_POS_INC  2-71 

:KEY:V_POS_DEC  2-71 

:KEY:V_SCALE_INC  2-72 

:KEY:V_SCALE_DEC  2-72 

:KEY:H_SCALE_INC  2-72 

:KEY:H_SCALE_DEC  2-72 

:KEY:TRIG_LVL_INC  2-72 

:KEY:TRIG_LVL_DEC  2-73 

:KEY:H_POS_INC  2-73 

:KEY:H_POS_DEC  2-73 

:KEY:PROMPT_V  2-73 

:KEY:PROMPT_H  2-74 

:KEY:FUNCtion  2-74 

:KEY:+FUNCtion  2-74 

:KEY:-FUNCtion  2-74 

:KEY:PROMPT_V_POS  2-74 

:KEY:PROMPT_H_POS  2-75 

:KEY:PROMPT_TRIG_LVL  2-75 

:KEY:OFF  2-75 

M 

:MATH:DISPlay  2-45 

:MATH:OPERate  2-45 

:MEASure:CLEar  2-54 

:MEASure:VPP?  2-54 

:MEASure:VMAX?  2-54 

:MEASure:VMIN?  2-54 

:MEASure:VAMPlitude?  2-55 

:MEASure:VTOP?  2-55 

:MEASure:VBASe?  2-55 

:MEASure:VAVerage?  2-56 

:MEASure:VRMS?  2-56 

:MEASure:OVERshoot?  2-56 

:MEASure:PREShoot?  2-57 

:MEASure:FREQuency?  2-57 

:MEASure:RISetime?  2-57 

:MEASure:FALLtime?  2-57 

:MEASure:PERiod?  2-58 

:MEASure:PWIDth?  2-58 

:MEASure:NWIDth?  2-58 

:MEASure:PDUTycycle?  2-59 

:MEASure:NDUTycycle?  2-59 

:MEASure:PDELay?  2-59 

:MEASure:NDELay?  2-60 

:MEASure:TOTal  2-60 

:MEASure:SOURce  2-60 

R 

:RUN  2-5 

S 

:STOP  2-5 

:STORage:FACTory:LOAD  2-43 

T 

:TIMebase:MODE  2-15 

:TIMebase[:DELayed]:OFFSet  2-15 

:TIMebase[:DELayed]:SCALe  2-16 
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:TIMebase:FORMat  2-16 

:TRIGger:MODE  2-20 

:TRIGger<mode>:SOURce  2-20 

:TRIGger<mode>:LEVel  2-21 

:TRIGger<mode>:SWEep  2-21 

:TRIGger<mode>:COUPling  2-22 

:TRIGger:HOLDoff  2-22 

:TRIGger:STATus?  2-23 

:Trig%50  2-23 

:TRIGger:EDGE:SLOPe  2-24 

:TRIGger:EDGE:SENSitivity  2-24 

:TRIGger:PULSe:MODE  2-25 

:TRIGger:PULSe:SENSitivity  2-25 

:TRIGger:PULSe:WIDTh  2-26 

:TRIGger:VIDEO:MODE  2-27 

:TRIGger:VIDEO:POLarity  2-27 

:TRIGger:VIDEO:STANdard  2-28 

:TRIGger:VIDEO:LINE  2-28 

:TRIGger:VIDEO:SENSitivity  2-28 

:TRIGger:SLOPe:TIME  2-30 

:TRIGger:SLOPe:SENSitivity  2-30 

:TRIGger:SLOPe:MODE  2-30 

:TRIGger:SLOPe:WINDow  2-31 

:TRIGger:SLOPe:LEVelA  2-32 

:TRIGger:SLOPe:LEVelB  2-32 

:TRIGger:ALTernation:SOURce  2-33 

:TRIGger:ALTernation:TYPE  2-33 

:TRIGger:ALTernation:TimeSCALe  

2-33 

:TRIGger:ALTernation:TimeOFFSet  

2-34 

:TRIGger:ALTernation<mode>:LEVel  

2-34 

:TRIGger:ALTernation:EDGE:SLOPe  

2-35 

:TRIGger:ALTernation<mode>:MODE  

2-35 

:TRIGger:ALTernation<mode>:TIME  

2-36 

:TRIGger:ALTernation:VIDEO:POLarity  

2-36 

:TRIGger:ALTernation:VIDEO:STANdar

d  2-37 

:TRIGger:ALTernation:VIDEO:LINE  

2-37 

:TRIGger:ALTernation:SLOPe:WINDow  

2-38 

:TRIGger:ALTernation:SLOPe:LEVelA  

2-38 

:TRIGger:ALTernation:SLOPe:LEVelB  

2-39 

:TRIGger:ALTernation<mode>:COUPli

ng  2-39 

:TRIGger:ALTernation<mode>:HOLDo

ff  2-40 

:TRIGger:ALTernation<mode>:SENSiti

vity  2-40 

W 

:WAVeform:DATA?  2-63 

:WAVeform:MEMORYDATA?  2-63 

:WAVeform:POINts:MODE 2-63
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